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Notices 

Copyright © 2017 - 2024, Quanergy Solutions, Inc. All rights reserved.  

This document is protected by copyright law, whereby all rights established therein remain with Quanergy 
Solutions, Inc. Reproduction of this document or parts of this document, without permission from Quanergy, is 
only permissible within the limits of applicable copyright law. Alteration or abridgement of the document is not 
permitted without the explicit written approval of Quanergy.  

QUANERGY, the QUANERGY logo, Q-Track, Q-Track-LR, Q-Track-HD, Q-Track Dome, QORTEX , QORTEX DTC 
and associated logos, QORTEX MXP, QORTEX PEOPLE COUNTER, QORTEX Aware, F540, M1, M1 Edge, M1 Edge 
PoE, M8, M8 Prime, M8 PoE, MQ, MQ-8, MQ-8 PoE, S3, Q-GUARD, Q-VIEW, Q-Vision, Q-Viewer, QSPU, 
QPU-L7, QPU MINI, MULTI-LIDAR FUSION, SENSORFUSION, Quanergy Insights are all trademarks of 
Quanergy Solutions, Inc. All other trademarks are the property of their respective owners.  

See also: 

• Acknowledgments of copyrighted material: http://downloads.quanergy.com/License.txt  

• End User Software License Terms that apply to all platforms hosting the Q-View software: 
http://downloads.quanergy.com/quanergy_end_user_software_license_terms.pdf 

ISO 9001:2015 Certified 

Contact 

Quanergy Solutions, Inc. 
128 Baytech Drive 
San Jose, CA 95134 
http://quanergy.com/ 

• For purchases made directly from Quanergy: contact 
support@quanergy.com  

• For purchases from a third party such as value-added 
reseller/system integrator: contact the third party for 
support 

Follow Us! 

 
https://www.linkedin.com/company/quanergy/ 

 
https://twitter.com/quanergy/ 

 
https://www.facebook.com/quanergy/ 

 
https://www.youtube.com/@QuanergySolutions/ 
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Revision History 

Version Date What Changed Change Location 

A 02/24/17 Released to support the Q-View 1.0 release. 

B 10/26/17 Released to support the Q-View 1.2 release and S3-1 Rev 1 sensor.  

Installs on user-supplied Linux 14.04 
certified PC, or Windows 7 or 10 system. 

Install Q-View on an Ubuntu System (24),  Install 
Q-View on a Windows System (25)  

Removed Mac OS support.   

Added Calibrate tab, daisy chaining files. Calibrating Sensors — Calibrate Tab (76) 

Added Record tab, with export of QLog 
data files to PCD or LAS formats.  

Recording Sensor Data — Record Tab (69), Export 
Recorded QLog File to Another Format (74)  

C 11/21/17 Added details to install Q-View on 
Windows 7/10. Use English-only 
characters. 

Install Q-View on a Windows System (25)  

D 01/02/18 Released to support the Q-View 1.2.84 patch release and S3-2 Rev 1 sensor.  

Added host computer minimum 
requirements.  

Required Functionality (19)  

Updated installation steps Installing Q-View (22)  

E 06/26/18 Released to support Q-View 1.3 release, Ubuntu 16.04, and M8 Rev D4P & D5. 

Added social media, updated legal notices Follow Us! (2), Notices (2)  

Updated installation instructions to refer to 
http://downloads.quanergy.com. 

Download Q-View and Documents (22) 

Added new ID and status information on 
sensor tiles. 

View the Sensor Diagnostics (53) 

Added menus in Visualize tab and Calibrate 
tab for selecting LIVE or PLAYBACK 
mode, a color scheme (Intensity, Ring 
Based, or Return), and Point size. 

Viewing Point Clouds — Visualize Tab (58), 
Calibrating Sensors — Calibrate Tab (76)  

F 08/17/20 Released to support Q-View 1.4 release, M-Series (M8 PoE+, MQ-8 PoE+) and S-Series (S3-
2NSI, S3-2NSO, S3-8) sensors. 

Omitted Windows 7 support, Dashboard network port buttons, English-only characters 
requirement for sensor labels, requirement to disconnect sensors before engaging 
PLAYBACK mode, daisy chaining concept, and the QLog export issue that no longer 
requires troubleshooting. 

http://downloads.quanergy.com/
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Version Date What Changed Change Location 

Changed terms for display area and point 
cloud area to visualization window, and 
defined terms for name versus label 

Viewing Point Clouds — Visualize Tab (58)  

Updated Contact (2), Documents (21), Installing Q-View (22), 
back cover 

Tab icon, selectability rules Calibrating Sensors — Calibrate Tab (76)  

Large scale performance specifications  Unique Features (18), Using the Q-View Interface 
(37), Search for Sensors on the Network (44)  

Recorder duration limiter Recording Sensor Data — Record Tab (69)  

Added sensor compatibility, minimum 
network bandwidth, display resolution 
support, 

Required Functionality (19)  

Populated timestamp in QLog exported to 
LAS 

Adjust the Grid Size (67), Use the World Calibration 
Controls (79), Create and Update a Fused Point 
Cloud (80)  

G 11/12/20 Released to support Q-View 1.5 Beta release, M8-PRIME sensor, M1 sensor, and Ubuntu 
18.04 support.  

Added M1 and M8-PRIME sensor content. Getting Started (18), Required Functionality (19), 
Documents (21), Filter the Sensor List (49), Select 
a Color Scheme (65), Detect Sensors Using 
Router-Assigned Dynamic IP Address (28)  

Updated dynamic sensor list Filter the Sensor List (49)  

Updated sensor minimum bandwidth Required Functionality (19)  

Updated Dashboard Tab field descriptions. 
Added FOV field. 

View the Sensor Diagnostics (53)  

Changed Ubuntu from 16.04 to 18.04 Connect to an Online Sensor (49), Required 
Functionality (19)  

Updated Ubuntu command Detect Sensors Using Port-Assigned Dynamic IP 
Address (29)  

Changed listing of S3-2NSI and S3-2NSO 
to S3-2 

Getting Started (18), Filter the Sensor List (49)  

Clarified text for Refine auto-alignment 
option 

Calibrating Sensors — Calibrate Tab (76)  

Changed reference source Documents (21) 
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Version Date What Changed Change Location 

H 05/14/21 Release Q-View 1.5. Support for M8-PRIME sensor, M1 sensor, and Ubuntu 18.04 support. 

Added dynamic sensor list Make a Sensor Detectable to the Host Computer 
(28)  

Added updating calibration XY offset range Make Changes to a Calibrated Group of Sensors 
(91), Use the Results (93), Edit 
quanergy.qview.calibration File (95)  

Added S3-2WSO sensor minimum network 
bandwidth 

Table 3. Sensor Minimum Network Bandwidth  

Updated NMEA/PPS/GPS messages. Table 10. NMEA/PPS GPS Status Messages  

Updated sensors. Figure 5. Host Computer: Connect Sensor to 
Network via Router (Example Addresses) 

Applied new template. Text Styles (7)  

J, Beta 1 07/13/21 Beta 1 Release Q-View 1.6 with QORTEX Aware.  

Added QORTEX Aware chapter: Object Detection — QORTEX Aware™ Tab (97)  

Updated Unique Features (18), Sensor Diagnostics Panel 
Details (55)  

Networking Table 3. Sensor Minimum Network Bandwidth, 
Figure 5. Host Computer: Connect Sensor to 
Network via Router (Example Addresses), Figure 
13. Q-View Interface, Table 5. Q-View Tabs 
Summary  

Q-View client interface Figure 15. Dashboard Tab: Interface, Table 8. 
Dashboard Tab: Sensor Filter Menu, Figure 31. 
Visualize Tab: Interface  

NMEA/PPS GPS status Table 10. NMEA/PPS GPS Status Messages  

J, Beta 2 09/17/21 Beta 2 Release Q-View 1.6 with QORTEX Aware.  

Moved QORTEX Aware API content to M1 Edge Sensor User Guide. 

Qortex Aware overview Object Detection — QORTEX Aware™ Tab (97)  

Clarify setting Evaluation Field through 
either sensor hardware pins (GPIO) or 
QORTEX Aware API. 

Set Active Evaluation Field (114)  

Clarify Qortex Aware web server Settings Modify Default Non-Zone Settings (113)  

Connected status. Settings file in Qortex 
Aware 

Connect to a QORTEX Aware Enabled Sensor (101)  
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Version Date What Changed Change Location 

Upload/download/save options. Select Settings File (103) Select Settings File (103) 

Object detection Unique Features (18) 

Requirements Required Functionality (19) 

Update Documents (21) 

Download for Beta Download Q-View and Documents (22) 

Client interface tabs, add Qortex Aware Tabs (38) 

Qortex Aware Monitor vs Configure mode QORTEX Aware Process Overview (98), 
QORTEX Aware Configuration in Q-View (99) 

J 11/16/21 Release Q-View 1.6 to support QORTEX Aware 1.0 

Debounce time updated Set Debounce Time (114) 

Polygon and Arc usage update Create Evaluation Field Zones (108) 

K beta 08/3/22 Release Q-View 1.7 and QORTEX Aware 2.0 

Settings file in QORTEX Aware Network File Actions (105)  

Support new sensors: M1 Edge PoE+, 
M8 PoE+ 

Table 2. Q-View Sensor Compatibility, Table 8. 
Dashboard Tab: Sensor Filter Menu, Required 
Functionality (19) 

Ubuntu version 20.04  Required Functionality (19), Operating System 
Platform Requirements (20) 

Evaluation field QORTEX Aware 2.0 Create Evaluation Field Zones (108), Figure 66. 
QORTEX Aware: Configuration Panel and 
Visualizer Elements,  Figure 72. QORTEX Aware: 
360° Field of View, Figure 78. QORTEX Aware: 
Visualizer with Evaluation Field Zones 

K 09/27/22 
11/04/22 

Add IPv6 address support Make a Sensor Detectable to the Host Computer 
(28),  Detect Sensors Using Router-Assigned 
Dynamic IP Address (28), Detect Sensors Using 
Port-Assigned Dynamic IP Address (29), IPv6 
Address Toggle (42) 

Add Ubuntu 20.04 support Operating System Platform Requirements (20) 

Add M1 Edge PoE, M8-Prime (PetaLinux) 
support 

Sensor Compatibility (19), Operating System 
Platform Requirements (20) 

Qortex Aware updates:  
• M1 Edge PoE  

QORTEX Aware Q-View Version Compatibility (98),  
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Version Date What Changed Change Location 

• 128 Zones 
• API content moved 

QORTEX Aware Evaluation Fields and Zones  (101), 
Create Evaluation Field Zones (108) 

Appendix 1. QORTEX Aware APIs and Settings 
Commands (129) 

Combined Sensor QLog Export Export Recorded QLog File to Another Format (74) 

M 12/08/24 Q-Track LR, HD, Dome sensor support.  

Text Styles 

In this guide certain fonts are applied to provide a visual means to interpret text.  

Table 1. Text Styles and Meanings 

Font Style Meaning 

Blue underline Hyperlink that opens a file outside of this document. Typically, this is a web page. 

Italic underline Hyperlink that moves you to a location within the document. Typically, this is a 
section, table, or figure.  

Bold General term for emphasis. Typically, this introduces a definition or description. 

Bold An item in a Graphical User Interface (GUI). This includes page, window, or panel 
labels, fields where you enter or select information, or checkboxes and buttons you 
click.  

Bold colors Examples of colors used in GUIs.  

Italic Identifies book or section titles. Provides emphasis for terms or ideas. Used to 
identify options for selecting from a menu, entering in a field, or replacing in a 
command string. 

Code italic Identifies a variable, where the intent is you provide a literal value in place of the 
variable. Used in paragraphs and code strings.  

Code Examples of commands you enter in a field or terminal, or responses from the 
system. 

Code on gray Examples of commands you enter into a command line interface (CLI) terminal or 
responses from the system. 

Text in box Notes and Tips. Useful related information. Format used to call attention to the 
content or to describe side-bar content.  

http://quanergy.com/
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Font Style Meaning 

Text in box 
Cautions and Warnings. Read these and comply with the information provided. 
Comply with Cautions or Warnings to prevent equipment damage or injury to 
humans and other living things. 
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 Getting Started 
Quanergy is pleased to offer Q-View™, a user-friendly sensor management and visualization software-based 
toolkit for the following Quanergy LiDAR sensors:  

M-Series, depending on the Q-View version: M1™, M1 Edge, M1 Edge PoE, M8™, M8-PRIME, M8 PoE+, MQ™-8 
PoE+. See Sensor Compatibility (page 19).  

This automated discovery system unleashes the full functionality of Quanergy artificial-intelligence-powered 
LiDAR-based sensing systems. Q-View provides robust information about a sensor network and its 
performance along with intuitive tools used to calibrate and align the sensors. 

Unique Features 

Q-View design incorporates new and exciting Quanergy products to provide improved safety, efficiency, and 
performance for the security, 3D mapping and surveying, transportation, and industrial automation markets. 
Such breakthroughs are made possible through Q-View’s unique features:  

• Informational Display. A sleek and automatic sensor discovery engine driven by the multicast Domain 
Name System (mDNS) protocol discloses a wealth of specific data about the network, the sensors on it, 
and their performance, while a manual search mode enables the discovery of a particular sensor on the 
network.  

• Intuitive Operation. Digital machinery operating in the background offers both automatic and manual 
modes for exploiting the full functionality of sensor query and diagnosis, visualization, recording, and 
calibration. The highly visual interface implements proven user patterns to enable users to grasp the 
consistent, intuitive controls right away.  

• Simple Calibration. Multiple sensors acting in concert provide an enriched perspective of a shared area 
of interest through a calibration tool that allows the user to quickly enable Multi-LiDAR Fusion™ by 
aligning connected sensors’ views, even for sensors that are not always within sight of each other.  

• Data Recording and Export. Controls simultaneous recordings of data collected by one or more LiDAR 
sensors. The recorder saves point cloud output in the QLog format, which can be exported to PCD or 
LAS formats.  

• Object Detection. Using M1 Edge and M1 Edge PoE+ sensors and QORTEX Aware™, notifies mobile 
and/or stationary listening devices when objects enter defined Evaluation Field zones. This enables 
programmatic responses to the detected objects, such as collision avoidance. 
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Required Functionality 

Functionality includes Q-View to Quanergy sensor compatibility, performance, communication, language, 
network bandwidth, display resolution, and platforms.  

Sensor Compatibility 

Q-View is fully compatible with the Quanergy LiDAR sensors. See Table 2. Q-View Sensor Compatibility. The 
model and revision level are stated on the sensor manufacturing label.  

Table 2. Q-View Sensor Compatibility 

Series Sensor Q-View Qortex Aware Notes 

M-Series M8 1.6, 1.7 1.0, 2.0 M8 sensor requires Rev D5 or later to report errors in the 
sensor diagnostics panel. See Figure 30. Dashboard Tab: 
Diagnostics Panel Sensor Error. 

M8-PRIME 1.6, 1.7 1.0, 2.0  

M8-PRIME 1.7 1.0, 2.0 PetaLinux 

M8 PoE+ 1.6, 1.7 1.0, 2.0  

MQ-8 PoE+ 1.6, 1.7 1.0, 2.0  

M1 1.6, 1.7 1.0, 2.0  

M1 Edge 1.6 1.0 QORTEX Aware pre-installed. Only supported in Q-View 
1.6. 

M1 Edge PoE+ 1.7 2.0 QORTEX Aware pre-installed. 

Q-Track  LR 1.7 2.0  

 HD 1.7 2.0  

 Dome 1.7 2.0  

Performance Requirements 

For best results in running the software, make sure the host computer meets these minimum specifications: 

• i3 processor 

• 4 GB memory 

• GeForce 8800, Radeon 4770, or other OpenGL compliant graphics 

Communication Requirements 

Quanergy LiDAR sensors are Ethernet devices that must have an IP address before they can interact on the 
network. The system on which the Q-View application is installed must allow mDNS multicast traffic and HTTP 
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traffic between sensors and host computer in both directions. Make sure you have proper communication 
between the LiDAR sensors, the Q-View host computer, and the Q-View application. 

Language Requirements 

To ensure that recording and exporting functions behave as expected, only English alphanumeric characters are 
allowed for file directory names and file paths. 

Network Bandwidth Requirements 

Must be able to support the minimum bandwidth requirements when streaming live point cloud data from the 
sensor. See Table 3. Sensor Minimum Network Bandwidth. 

Table 3. Sensor Minimum Network Bandwidth 

Sensor Type Minimum Bandwidth 

M8, M8-PRIME, M8 PoE+, MQ-8-PoE 20 Mbps per sensor in 1 return mode. 

60 Mbps per sensor in 3 return mode. 

M1, M1 Edge, M1 Edge PoE+ 6 Mbps per sensor in 1 return mode. 

9 Mbps per sensor in 3 return mode. 

Q-Track LR  

 

Q-Track HD, Q-Track Dome  

 

Display Resolution Supported 

Q-View scales up from a minimum width of 1024 and a minimum height of 768. Q-View supports the following 
display resolutions:  

1920x1080 1440x900 1280x1024 

1024x768 1600x900 1536x864  

1366x768 1280x800 1680x1050 

Operating System Platform Requirements 

For this version of the Q-View application, use the following Linux® and Windows® platforms. Some of the 
differences in common commands are listed below. Also see Table 4. Q-View Version for Supported Operating 
Systems. 

• Linux® —Use a certified Linux Ubuntu 20.04 LTS (Focal Fossa) or 18.04 LTS (Bionic Beaver) operating 
system. A helpful list of desktops/laptops can be found at https://certification.ubuntu.com/. 

https://certification.ubuntu.com/
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• Windows® 10 System 

• Host machine CPU must support AVX2. 

Table 4. Q-View Version for Supported Operating Systems 

OS Platform Windows 10 Ubuntu 20.04 LTS Ubuntu 18.04 

M8 Q-View 1.6 n/a Q-View 1.6 

M8-Prime Q-View 1.6, 1.7 Q-View 1.6, 1.7 Q-View 1.6, 1.7 

M8-Prime PetaLinux Q-View 1.7 Q-View 1.7 Q-View 1.7 

M8 PoE+ Q-View 1.6, 1.7 Q-View 1.7 Q-View 1.6, 1.7 

MQ -8 PoE+ (MQ-8) Q-View 1.6, 1.7 Q-View 1.7 Q-View 1.6, 1.7 

M1 Q-View 1.6, 1.7 Q-View 1.6 Q-View 1.6, 1.7 

M1 Edge Q-View 1.6, 1.7 Q-View 1.6 Q-View 1.6, 1.7 

M1 Edge PoE+ Q-View 1.6, 1.7 Q-View 1.6 Q-View 1.6, 1.7 

Q-Track LR    

Q-Track HD    

Q-Track Dome    

Documents 

Q-View assumes familiarity and proper setup of your Quanergy LiDAR sensors. To access the latest versions of 
the essential Q-View documents: 

• Datasheets: Q-Track Sensor Datasheet list the specifications defining the sensor. This document can be 
downloaded from http://quanergy.com/downloads/ 

• User Guides and Quick Start Cards: Q-Track Sensor User Guides and Sensor Quick Start Cards explain the 
specifications, setup, and management of the LiDAR sensors. These documents are available upon 
request from support@quanergy.com 

• Q-View User Guide (this guide) and Q-View Quick Start Card explain how to manage single sensors 
and groups of sensors. Download these documents from http://downloads.quanergy.com/.  

 

http://quanergy.com/downloads/
mailto:support@quanergy.com?subject=Support%20Documentation
http://downloads.quanergy.com/
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 Installing Q-View 
This section describes how to install Q-View on a host computer that is on the same network as Quanergy 
LiDAR sensors and how to make those sensors detectable to the host. 

Download Q-View and Documents 

Access documents explaining the installation process, as follows. See Figure 1. Quanergy Download Center. 

1. Open a browser and enter the Quanergy Download Center URL, http://downloads.quanergy.com.  

2. Download the legal and user documents.  

a. Click the link. This opens a PDF or text file of the document in a browser.  

b. Save the file from the browser, as needed.  

The documents are: 

o End User Software License Terms—You must agree to these terms before downloading Q-View. 
o Acknowledgments—This provides acknowledgment for copyrighted and open-source material 

Quanergy Software might use. 
o Q-View User Guide—This guide. 
o Q-View Quick Start Card—A summary card for Q-View requirements, installation, and usage. 

3. Enable the Q-View software download links. Click the checkbox: To download software, please agree to 
the End User Software License Terms 

4. To download Q-View installer on Linux— 

a. Click the Linux link. It opens the qview_readme.txt.  

b. Locate the download page URL in the qview_readme.txt.  

c. Open a browser on your Ubuntu machine and enter the Linux download page URL. 
http://downloads.quanergy.com/qview/linux/ 

d. Click the Q-View Debian package, quanergy-qview_1.5.xxx_amd64.deb.  

Where xxx is the release number. 

The link downloads the installer to your local /Downloads directory.  

e. Proceed to Install Q-View on an Ubuntu System (page 24).   

http://downloads.quanergy.com/
http://downloads.quanergy.com/qview/linux/
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5. To download Q-View installer on Windows— 

a. Click the Windows link.  

The link downloads the installation executable, Q-View-1.5.xxx-win64.exe, to your local 
/Downloads directory.  

Where xxx is the release number. 

b. Proceed to Install Q-View on a Windows System (page 25). 

 

  
Figure 1. Quanergy Download Center 

Downloads.quanergy.com 1 

2 

3 
4, 5 
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Install Q-View on an Ubuntu System 

Install Q-View on an Ubuntu machine, as follows: 

1. Ensure your environment meets the network, sensor, and installation machine requirements. See 
Required Functionality (page 19). 

2. If you have a previous version of Q-View, uninstall it.  

a. From your Ubuntu machine, open a terminal.  

b. Run the command. 

 $ sudo dpkg -r <package-name> 

3. If you prefer to use Q-View in isolation from unsecured networks: 

a. Locate the installer package in the /Downloads directory.  

b. Transfer that package to an external USB or hard drive.  

c. Connect that hard drive to the preferred “air-gapped” computer. 

d. Transfer the package to whichever directory you prefer, such as ~/Downloads. 

4. Open a terminal window on your Ubuntu host computer.  

Note:  The Ubuntu host machine must be on the same network as the sensors. 

5. Run the installation commands. 

 $ cd ~/Downloads  

 $ sudo dpkg -i quanergy-qview_1.6.xxx_amd64.deb 

 Where xxx is the release number. 

All programs and libraries are placed where they are needed.  

6. Proceed to detecting sensors. See Make a Sensor Detectable to the Host Computer (page 28). 
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Install Q-View on a Windows System 

Install Q-View for the Windows platform, as follows: 

1. Ensure your environment meets the network, sensor, and installation machine requirements. See 
Required Functionality (page 19). 

2. If you prefer to use Q-View in isolation from unsecured networks: 

a. Locate the installer executable in the /Downloads directory.  

b. Transfer that package to an external USB or hard drive.  

c. Connect that hard drive to the preferred “air-gapped” computer. 

d. Transfer the package to whichever directory you prefer, such as ~/Downloads. 

3. Start the Windows installation wizard.  

From the /Downloads folder, double-click the executable, Q-View-1.6.xxx-win64.exe file.  

Where xxx is the release number. 

4. Confirm making changes to your system, if prompted.  

In the prompt: Do you want to allow this app to make changes...? click Yes. The Wizard then 
continues.  
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5. Uninstall previous version of Q-View, if prompted.  See Figure 2. Windows Computer: Uninstall Old 
Q-View. 

a. In the prompt: Q-View is already installed. Do you want to uninstall the previous 
version before installing the new one? click OK.  

b. In the wizard Uninstall Q-View panel, click Uninstall to confirm. 

c. In the wizard Uninstallation Complete panel, click Close. 

 

   
Figure 2. Windows Computer: Uninstall Old Q-View 

5b 5c 

5a 
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6. Accept the defaults and prompts from the installation Q-View Setup wizard panels. See Figure 3. 
Windows Computer: Step Through the Q-View Installation Wizard. 

a. Agree to continue the Q-View Setup wizard, click Next.  

b. Accept the License Agreement, click I Agree.  

c. Accept the default C:\Program Files\Q-View destination or navigate to a different location folder, 
click Next.  

d. Accept the default Start Menu folder name, Q-View or enter a new name. Click Next. This is the 
folder where short-cuts are stored. 

e. Select components to install. Select the bundle checkbox. Then click Install. 

f. Wait while installation completes. Optionally, monitor the status bar.  

      

      
Figure 3. Windows Computer: Step Through the Q-View Installation Wizard 

7. Dismiss the wizard when complete, click Finish. See Figure 4. Windows Computer: Finish the Q-View 
Installation. 

Notice that a shortcut Q-View icon is now on the desktop as a quick way to start the Q-View 
application. All programs and libraries are stored where they are needed.  

6a 6b 

6e 

6f 

6c 

6d 
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8. Proceed to detecting sensors. See Make a Sensor Detectable to the Host Computer (page 28). 

    
Figure 4. Windows Computer: Finish the Q-View Installation 

Make a Sensor Detectable to the Host Computer 

Q-View can easily detect a Quanergy LiDAR sensor when it is connected to the host computer through the 
network that can assign a dynamic IP address. Q-View supports IPv4 and IPv6 addresses. 

• Using a router-assigned dynamic IP address method is the simplest and most resilient way for sensors to 
interact with the you on either Ubuntu or Windows computing environments. This is the recommended 
method. See Detect Sensors Using Router-Assigned Dynamic IP Address (page 28). 

• Using a port-assigned dynamic IP address, is an alternative that connects directly to the host computer 
network port when Q-View is installed on an Ubuntu system. See Detect Sensors Using Port-Assigned 
Dynamic IP Address (page 29). 

Note:  If you choose to connect using a different method than described here, 
call your support representative, if needed.  

Detect Sensors Using Router-Assigned Dynamic IP Address 

For the all-around best approach to making a sensor detectable by the Ubuntu or Windows host computer. See 
Figure 5. Host Computer: Connect Sensor to Network via Router (Example Addresses). 

1. Connect a dynamically set sensor to a router that is on the same network as the host computer. 

Note:  For this method, the sensor cannot be configured to have a static IP 
address. 

2. Connect the sensor to power.  

7 
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3. The router DHCP server automatically assigns the sensor a dynamic IP address that has the same 
network address as the computer.  

This enables the computer and sensor to communicate. Example dynamic IP address: 10.1.11.x. Where 
the x indicates a specific value assigned to each sensor and the computer. 

Q-View supports IPv4 and IPv6 addresses. If your sensor supports it, and you want to only show the 
IPv6 address, turn the IPv6 Address toggle to ON. 

 
Figure 5. Host Computer: Connect Sensor to Network via Router (Example Addresses) 

Detect Sensors Using Port-Assigned Dynamic IP Address 

Alternatively, for Ubuntu-only environments, to avoid using a router, you can instead connect a single M-Series 
or S-Series Q-Track sensor (via the ethernet port) directly to the host computer. You’ll need to set up a DHCP 
server that can assign IP addresses on the network port, as shown in Figure 6. Ubuntu Computer: Connect Sensor 
to Network Port (Example Addresses) with the M8 Q-Track LR sensor as an example and instructed below.  

 
Figure 6. Ubuntu Computer: Connect Sensor to Network Port (Example Addresses) 
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1. Email your support representative at support@quanergy.com to request the quanergy_net_install 
installation script.  

2. Download the quanergy_net_install installation script to your Ubuntu host computer.  

3. From the Downloads directory, or wherever it was placed in the host computer, double-click the 
quanergy_net_install.zip file. 

4. In the quanergy_net_install.zip window that appears, click the Extract button. See Figure 7. Ubuntu 
Computer: Extract DHCP Server Installation Script. 

 
Figure 7. Ubuntu Computer: Extract DHCP Server Installation Script 

5. Select the directory to extract the files. 

In the Extract window that appears. See Figure 8. Ubuntu Computer: Assign Location for the Extracted Files. 

o To leave the extracted file in the Downloads directory, click Extract. 
o To select a different location for the extracted file to reside, navigate to the preferred directory, and 

click Extract. 

mailto:support@quanergy.com%20?subject=Support:%20Quanergy%20net%20installation%20script
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6. In the Archive Manager window confirmation, Extraction completed successfully, choose and 
option: 

o Quit to dismiss the Archive Manager. 
o Show the Files to check files that were extracted.  

See Figure 8. Ubuntu Computer: Assign Location for the Extracted Files. 

 

Figure 8. Ubuntu Computer: Assign Location for the Extracted Files 

7. Open a terminal window (Ctrl+Alt+T), then take the following actions in it to set up the DHCP server. 

a. Navigate to the directory where the installation script was extracted into. 

b. At the prompt, execute this command to update all required packages: 

  $ sudo apt update 

c. At the prompt, execute this command to configure the network to be able to run the DHCP 
installation script: 

  $ sudo bash quanergy_net_install 

d. When prompted for a password, enter your usual password.  

e. When prompted for “Configure dhcp server? [y/n],” type y, and press the Enter key. (If your 
DHCP server is already set up, this prompt doesn’t occur.) 
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f. When prompted for “Ethernet interface,” type 0 to make eth0 the network port the sensor 
connects to, then press the Enter key. (This is an example, which depends on your specific host 
computer setup.) 

g. When prompted to create an “IP address” for the Ethernet port, type an IP address that matches 
the subnet, and whose host address is 1, such as 10.0.0.1), then press the Enter key.  

Q-View supports IPv4 and IPv6 addresses. If your sensor supports it, and you want to only show the 
IPv6 address, turn the IPv6 Address toggle to ON. 

8. Reboot the computer to apply the changes, making the Ethernet port a DHCP server that assigns IP 
addresses of 2-255 on its subnet to any device that plugs into it.  

9. Connect the sensor to the newly activated port, then connect the sensor to power.  

10. Label the hardware for this port “DHCP” to prevent accidental connection to a LAN/internet cable.  

CAUTION: 
If you connect the sensor to a router or change to a different network, a new IP 

address may be dynamically assigned to the sensor this overwrites the current IP 
address. 
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 Starting and Stopping Q-View 
The Q-View application offers simple mechanisms for starting, restarting, and refreshing the Q-View network 
search.  

Start Q-View 

1. Login to your Q-View machine.  

2. Depending on your computing environment, perform the action: 

For Ubuntu: Open a terminal window, and execute the following command: 

 $ /opt/quanergy/Q-View/Q-View 

For Windows:  In the GUI, click the icon that appears on the desktop, or search for and select the 
Q-View application. See Figure 9. Q-View Launch Icon: Ubuntu (left), Windows (right). 

        
Figure 9. Q-View Launch Icon: Ubuntu (left), Windows (right) 

In Windows, to open a new terminal window, press Win+X, and select Command Prompt. 

Q-View welcome window appears very briefly with a LOADING timer. See Figure 10. Q-View Welcome 
Window. 

 
Figure 10. Q-View Welcome Window 
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3. Wait while Q-View performs a 30-40 second initial network search and several background operations: 

o Q-View scans all of the host computer network adapters to discover and display all sensors found. 

Note:  Quanergy highly recommends the use of Ethernet rather than WiFi. The 
WiFi network adapter requires a stable connection and a high bandwidth 
sufficient to support the minimum requirements. If WiFi is necessary, a dedicated 
WiFi network for the sensors is recommended. See Required Functionality (page 
19). 

o Q-View recalls all sensors that were found during previous work sessions. During the search, 
previously labeled sensors are represented briefly as tiles in the Empty (transparent) state. If they 
respond to Q-View query, they quickly change into the Online (blue) state, but if they never respond 
to the query, they change into the Offline (gray) state. Newly discovered sensors appear in the 
Online (blue) state. See Figure 11. Q-View Scan Returns List of Sensors Found and Table 9. Dashboard 
Tab: Sensor States. 

Note:  The Q-View host computer and all discovered sensors share the same 
subnet, that is, have the same first three octets in the IP address (e.g., 10.1.11.x) 
UNLESS your network installation supports publishing mDNS traffic over routers, 
causing a Q-View scan of each network to yield similar or identical results that 
include multiple subnets.  

o Q-View scans for Q-View included applications and displays each in a separate tab.  

 
Figure 11. Q-View Scan Returns List of Sensors Found 

IPv6 Address toggle Disconnect sensors toggle 
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4. If Q-View does not find a network connection:  

o The refresh button does not appear, and the network search is not available.  
o Previously labeled sensors might appear in an Offline (gray) state. See Figure 12. Q-View Scan 

Displays Offline Sensors Even Without Network Connection.  
o Quit Q-View, fix the network connection, and start Q-View again. See Starting and Stopping Q-View 

(page 33). 

 
Figure 12. Q-View Scan Displays Offline Sensors Even Without Network Connection 

Refresh Network Search 

Refresh the network search when: 

• You want to discover whether new sensors have been added. 

• You expected to see a particular sensor show up (because you know it is plugged in and powered on), 
but it does not appear in the list of sensor tiles. 

• You thought there would be more sensors in the list than actually appeared. 

• You see some other unexpected, undesirable sensor or network behavior.  

Anomalies and errors can occur for many reasons, including network configuration and traffic issues. To give 
Q-View the opportunity to resolve any of these issues: 

1. Click the Search network  button to refresh the list. See Figure 11. Q-View Scan Returns List of Sensors 
Found. 

2. If the situation is not yet resolved, wait until the previous search concludes, then click the Search 
network  button again. 

3. Repeat until the search results meet your expectations.  

4. If necessary, restart the Q-View application.  

If Q-View found a network connection but did not detect any sensors on the network, the lack of sensors is 
reported. If necessary, you can manually add the IP address of sensors you know are on the network. See Figure 
22. Dashboard Tab: No Network Found (right), No Sensors Found (left), Search for Sensors on the Network (44) and 
Sort the Sensor List (page 48). 
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Stop Q-View 

Select the method for your computing environment. 

For Ubuntu: 

1. Open a terminal window, press Ctrl+Alt+T. 

2. Quit/close an application or window, select a method: 

o Click the red Close  button in the upper left corner of the window. 
o Press Ctrl+C on the keyboard. 

For Windows: 

To quit/close the current Q-View window, select a method: 

o Click the red Close  button in the upper right corner. 
o Press Win+Ctrl+F4. 
o Click the Q-View menu Close item. 
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 Using the Q-View Interface 
After initial scanning operations are complete, the Q-View application interface enables the user to access tools 
for taking actions related to the LiDAR sensors and the data they gather. Q-View scales proportionally when the 
screen is set to a common display resolution. See Figure 13. Q-View Interface and Required Functionality (page 
19). 

 
Figure 13. Q-View Interface 

Quit Button 

The Quit button style and location varies depending on which platform is hosting the Q-View application. See 
Figure 13. Q-View Interface and Starting and Stopping Q-View (page 33). 

Version 

Q-View states its version in the upper window frame. See Figure 13. Q-View Interface. 

Tabs 

Q-View Version Q-View icon 

Quit 

Sensor management 
panel – Dashboard tab 
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Tabs 

Q-View offers specific sets of tools accessed through the Dashboard, Visualize, Record, Calibrate, and QORTEX 

Aware tabs. In the tab list, the active tab is green, . See Figure 13. Q-View Interface and Table 5. Q-View Tabs 
Summary. 

Table 5. Q-View Tabs Summary 

Icon Name Purpose 

 

Dashboard tab Sensor management tools to help discover, label, use, and diagnose available 
sensors on the network. Q-View starts with this tab open. See Managing Sensors — 
Dashboard Tab (page41). 

 

Visualize tab Visualization tools to verify that a particular sensor is operational by displaying its 
point cloud and manipulating its perspective. See Viewing Point Clouds — Visualize 
Tab (page 58). 

 

Record tab Data tools to save the direct point cloud output of one or more connected sensors 
in Quanergy proprietary QLog format for export to PCD or LAS formats. See 
Recording Sensor Data — Record Tab (page 69). 

 

Calibrate tab Calibration tools to transform the body frame of a second sensor into the fixed 
body frame of the first sensor so that they share the same Origin on the XYZ axes. 
See Calibrating Sensors — Calibrate Tab (page 76). 

 

QORTEX Aware 

tab 
Object detection tools to notify mobile and stationary listening devices when an 
object has crossed into Evaluation Field zones. See Object Detection — QORTEX 
Aware™ Tab (page 97) 

Tooltips 

Hovering over a widget in any tab often reveals an explanatory tooltip. See Figure 14. Q-View Interface: Hovering 
Reveals Tooltip. 

 
Figure 14. Q-View Interface: Hovering Reveals Tooltip 

Widget 

Hovering Pointer 

Tooltip 
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Files 

A variety of files are available to support the Q-View application and are produced through the Q-View 
application. Those files and their default locations Table 6. Q-View Default File Locations. 

Note:  To ensure that recording and exporting functions behave as expected, 
only English alphanumeric characters are allowed for file directory 
names/filepaths.  

Table 6. Q-View Default File Locations 

Platform File Figure Default Location 

Ubuntu Record tab data output:   

Sensor Settings  Figure 48. Record Tab: Output 
Directory: Settings & Exported 
Files, QLog, PCD Format 

~/YYYY-MM-DD_HH-MM-

SS.TTT/sensor_settings.xml 

QLog data   ~/YYYY-MM-DD_HH-MM-

SS.TTT/sensorname.q00 

Record tab data export:    

cloud000000.pcd Figure 48. Record Tab: Output 
Directory: Settings & Exported 
Files, QLog, PCD Format 

~/cloud000000.pcd 

cloud000000.las  ~/cloud000000.las 

Calibrate tab data output:   

Transform Alignment Figure 62. Calibrate Tab: 
transform_alignment.xml File 

~/UserDefinedFolder/transform_

alignment.xml  

Calibration Figure 52. Calibrate Tab: Where to 
Store Calibration Files 

~/UserDefinedFolder/calibratio

n.ini 

Windows Record tab data output:   

Sensor Settings   C:\Users\username\YYYY-MM-

DD_HH-MM-

SS.TTT\sensor_settings.xml 

QLog data   C:\Users\username\YYYY-MM-

DD_HH-MM-SS.TTT\sensorname.q00 

Record tab data export:    

cloud000000.pcd  C:\Users\username\cloud000000.

pcd 
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Platform File Figure Default Location 

cloud000000.las  C:\Users\username\cloud000000.

las 

Calibrate tab data output:    

Transform Alignment  C:\UserDefinedFolder\transform

_alignment.xml 

Calibration  C:\UserDefinedFolder\calibrati

on.ini 

 

To keep your exported files from being overwritten by the subsequent export from a different set of data 
output, make sure your file path leads to the YYYY-MM-DD_HH-MM-SS.TTT folder of the original QLog file being 
exported. This does not happen by default. 
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 Managing Sensors — Dashboard Tab 
From the Dashboard tab, manage the available sensors on the network. This involves discovering sensors on 
the network, connecting to them, labeling them, checking their vital statistics, and disconnecting from them. Up 
to 50 sensors can be included on the dashboard. See Figure 15. Dashboard Tab: Interface. 

View the Dashboard Panel  

Click the Dashboard tab. Q-View opens the Dashboard panel. See Figure 15. Dashboard Tab: Interface. 

 

 

 
Figure 15. Dashboard Tab: Interface 

Add New Sensor by IP Address 

If you know a sensor is on the network, but the search mechanisms have not listed it, the + ADD NEW sensor 
tile allows you to search the network by the sensor specific IP address to find and display it. See Search 
Manually for Sensors using IP Address (page 46).  

Search and Sort 
Filters Tallies 

Sensor Tiles, States, Names Search 
Network Disconnect 

All 
Scroll Bar 

Add sensor by IP 

IPv6 Address toggle 
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IPv6 Address Toggle 

To list sensor IPv6 addresses, toggle the IPv6 address ON.  

• By default, all sensors with IPv4 addresses are included.  

• If sensors have both and IPv4 and IPv6 addresses, and the IPv6 address toggle is OFF, both the IPv4 and 
IPv6 addresses are listed.  

• If the IPv6 address toggle is ON, all sensors with IPv6 addresses are listed, however due to the length of 
IPv6 addresses, the full address is not listed in the sensor tile. Hover over the IPv6 address to view the 
entire address or view the sensor Diagnostics panel. 

 
Figure 16. Sample Sensor Diagnostic Panel - IPv6 Toggle OFF 

 
Figure 17. Sample Sensor Diagnostics Panel - IPv6 Toggle ON 

Search Network Button 

After the initial scan, you can refresh the search results by clicking the Search network  button. The search 
takes a few seconds, then updates the list of sensors. See Figure 15. Dashboard Tab: Interface, Search for Sensors 
on the Network (page 44), and Sort the Sensor List (page 48).  
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Disconnect All Button 

If many sensors are in a Connected (green) state, you can disconnect them all at once by clicking the 
Disconnect All button. This is handy when you are done calibrating a group of sensors, and you need to connect 
and calibrate a new group of sensors. See Figure 15. Dashboard Tab: Interface. 

Scroll Bar 

The tiles of all the sensors on your network may not fit on a single page view. Use the scroll bar along the right 
side of the Dashboard tab to scroll up and down through all of them.  

Add a Sensor to Q-View 

1. From Q-View, select the Dashboard tab. See View the Dashboard Panel (page 41) and Figure 18. Q-View 
Dashboard Tab: Initial.  

Q-View discovers sensors on the same network as Q-View and displays them in the list of tiles on the 
Dashboard panel. 

 
Figure 18. Q-View Dashboard Tab: Initial 

2. Search for a sensor. See Sort the Sensor List (page 48) and Figure 19. Sort Sensor Menus. 

 
Figure 19. Sort Sensor Menus 
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3. If the sensor you are looking for is not listed, select a method to search for a sensor. See Search for 
Sensors on the Network (page 44) and Figure 20. Search for Sensors Buttons.  

  
Figure 20. Search for Sensors Buttons 

4. Connect a sensor. See Connect to an Online Sensor (page 49) and Figure 21. Connect Sensor Button. 

 
Figure 21. Connect Sensor Button 

Search for Sensors on the Network 

After the initial startup scan is conducted, you can discover added sensors by automatic search through the 
Search network  button. Both the initial startup scan and the Search network button perform a broad 
automatic mDNS search process according to network search rules.  

Q-View also offers several ways to manually search for and sort all sensors on the network.  

• By typing an IP address into a +ADD NEW tile, then pressing the Enter key. See Search Manually for 
Sensors using IP Address (page 46). 

• By selecting search criteria (Name, IP, or MAC), typing the specific string in the data field, and clicking the 
Search  button. See Search Manually for Sensors (page 47). 

• By sorting the sensors alphabetically (Name A-Z or Name Z-A) or by MAC address, IP address, or Model 
Number. See Sort the Sensor List (page 48). 

• By selecting a category (All Sensors, Connected, Online, Offline, Labeled, Malfunctioning, or each 
model name) of sensors. See Filter the Sensor List (page 49). 

Connected sensor Connect the sensor button 



Q-View User Guide 
 
 

 

©2024 Quanergy Solutions, Inc Q-Vew User Guide, QPN 96-00015 Rev M Page 45 

Network Search Rules 

An automatic search follows specific network search rules: 

• If a sensor is in a Connected state, it becomes persistent and is unaffected by subsequent searches.  

• If you click the Search network  button again, the list is cleared (except for the persistent Connected 
sensors) and refreshed by the results of the new search.  

• While a search is in progress, the interface is locked, preventing the user from initiating any other 
activity until the search process completes. The  spinner rotates to indicate that it is in search mode. 
You can click the spinning Search network  button again to stop the search. 

Any new sensors that are discovered appear as tiles in the list, along with the persistent Connected sensors.  

Search Automatically for Sensors via mDNS  

To search for available sensors via automatic mDNS broadcast: 

1. Click the Search network  button to immediately refresh a previous network search or activate a new 
search. The list of available sensors changes to reflect the current network. 

2. If a previously labeled sensor is not discovered, it displays as an Offline (gray) tile, which can be deleted 
from the list by clicking its Delete  button. See Figure 12. Q-View Scan Displays Offline Sensors Even 
Without Network Connection. 

3. If you don’t get the results you want. See Figure 22. Dashboard Tab: No Network Found (right), No Sensors 
Found (left). 

o When the current network is available, but no sensors are found, a NO SENSORS FOUND message 
appears.  

o When the current network is not available, and no Offline tiles are listed, a NO NETWORK FOUND 
message appears.  

Additional options:  

o Quit Q-View. 
o Fix the network connections.  
o Restart Q-View. 

 
Figure 22. Dashboard Tab: No Network Found (right), No Sensors Found (left) 
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Search Manually for Sensors using IP Address 

The manual search is a useful shortcut for new sensors that were just added or are on a sub-network that is not 
directly discoverable.  

To search for a sensor whose IP address you know:  

1. If there is an automatic search in progress, wait for it to end. 

2. Click the +ADD NEW tile. That tile transitions to include four numeric fields separated by periods, and a 
blinking cursor prompts the user to type. See Figure 23. Dashboard Tab: Add New Sensor Sequence. 

   
Figure 23. Dashboard Tab: Add New Sensor Sequence 

3. Type the sensor known IP address in the octet fields. 

o Include the dot (.) to automatically move to the next field in the IP address.  
o Press the Tab key or period to complete the current field and skip to the next. 
o Press arrow keys to move forward or backward through three digits in each octet. 
o Press the Backspace key to delete a digit. 

4. Press the Enter key or click in the Adding a new sensor panel, to activate the search for the sensor with 
that IP address. See Figure 24. Dashboard Tab: Manual Search Results: Online (left) or Not Found (right). 

o If Q-View instantly reverts to the original empty +ADD NEW tile, then that sensor is already in the 
list of sensor tiles, that is, you searched for an already found sensor. 

o If the IP address appears valid by being in the standard format, Q-View does this: 

▪ Locks the IP address fields to prevent changes mid-scan. 
▪ Pings the IP address to determine that it is live on the network. 
▪ Issues the HTTP request for sensor information. 
▪ Displays a spinner while awaiting response. (For a healthy, available sensor, this should take five 

seconds at most.)  
▪ Creates a new Sensor # tile in an Online (blue) state when the sensor responds with the 

information as expected.  

o If the address appears invalid by being in the wrong format (for example, use of alpha characters, 
octet greater than 255, or not all fields completed), Q-View changes the sensor tile message to 
Sensor not found and allows the following.  

1) Click in an octet field and edit the IP address. 
2) Press the Esc (Escape) key while editing to display previously entered values. 
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o If an apparently valid IP address is not found or the search times out, Q-View changes the tile text to 
yellow and displays a Sensor not found message with a warning icon, then allows you to take one of 
the following actions.  

1) Click the IP address and press the Enter key to search the same IP address. Sensors can take up 
to a minute to restart and be recognized on the network. 

2) Click the IP address and edit it, then press the Enter key to search again.  
3) Delete the Not Found tile by clicking its Delete  button.  

  
Figure 24. Dashboard Tab: Manual Search Results: Online (left) or Not Found (right) 

Search Manually for Sensors 

If you know a sensor name (or label), MAC address, or IP address, you can search for it directly using the Search 
menu and field, as follows: 

1. Select the item (Name, MAC, or IP) you prefer to search for from the Search menu on the far left of the 
Search mechanism. Searching by Name is the default option. See Figure 25. Dashboard Tab: Sensor Search 
Menu and Field. 

2. In the Search field, type the name or label for the sensor(s) you wish to find. 

3. Click the Search   button (or press the Enter key) to activate the search. All sensor tiles that match the 
search criteria will appear on the Dashboard tab, in the order assigned by the Sort menu and filtered by 
the Filter menu. See Table 7. Dashboard Tab: Sensor Sort Menu and Table 8. Dashboard Tab: Sensor Filter 
Menu. 

 
Figure 25. Dashboard Tab: Sensor Search Menu and Field 
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Sort the Sensor List 

If you have a large number of sensor tiles on display, you may sort them by using the drop-down Sort menu in 
the upper-left area of the Dashboard tab. Each item in the Sort menu. See Figure 15. Dashboard Tab: Interface 
and Table 7. Dashboard Tab: Sensor Sort Menu. 

Table 7. Dashboard Tab: Sensor Sort Menu 

Drop-Down Menu Select Sort  Result 

  Name A-Z (default) Sorts sensors alphabetically in ascending order by original names and 
updated labels. 

Name Z-A Sorts sensors alphabetically in descending order by original names 
and updated labels. 

IP Sorts sensors numerically in ascending order by each octet (1-999) of 
the IP address. 

MAC Sorts sensors numerically in ascending order (1-9) by the last six digits 
of the sensor MAC address (identical to the last six digits of the 
sensor serial number). The MAC address is stated on the diagnostics 
panel, and the serial number is stated on the sensor tile and 
diagnostics panel. See Figure 28. Dashboard Tab: Diagnostics (...) 
Button. 

Model Number Sorts sensors alphanumerically in ascending order by the model 
number. 
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Filter the Sensor List 

As the complete list of discovered sensors overflows beyond the visualization window, you can adjust which 
sensors remain in view with these mechanisms. See Figure 15. Dashboard Tab: Interface. 

• Drag the right-hand scroll bar.  

• Resize the window to change the size of the visualization window. 

• Filter the listed sensors to display only certain categories of sensors: 

o Click the drop-down filter menu in the upper-left area of the window. 
o Select which category you want to display. See Table 8. Dashboard Tab: Sensor Filter Menu. 

The sensor filter list selection lists the sensors model numbers that are in the dashboard.  This list dynamically 
updates to show only available sensors according to the sensors in dashboard. 

Table 8. Dashboard Tab: Sensor Filter Menu 

Drop-Down Menu Select Filter Display Tile States Tile Colors 

 All Sensors Empty, Online, Connected, 
Malfunctioning, Offline, Not Found 

Transparent, Blue, 
Green, Red, Gray, Black 

Connected Connected Green 

Online Online, Connected, Malfunctioning Blue, Green, Red 

Offline Offline Gray 

Labeled Any tile assigned a nickname Blue, Green, Red, Gray 

Malfunctioning Malfunctioning Red 

M1 (M1-PLUS, M1-CORE, 
M1-ULTRA) 

Empty, Online, Connected, 
Malfunctioning, Offline, Not Found 
The list of sensors dynamically 
changes as sensors are detected on 
or removed from the network. 

Transparent, Blue, 
Green, Red, Gray, Black 

M1 Edge, M1 Edge PoE+ 

M8, M8-Prime, M8-PoE+ 

MQ8-PoE+ 

Q-Track LR, Q-Track DM, 
Q-Track Dome 

  

Connect to an Online Sensor 

You can only visualize, record, and calibrate sensors that are in a Connected state. To connect to a sensor that 
is in an Online (blue) state: 
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1. Click the Connect (+) button on the sensor tile. The button is replaced by a spinner that indicates the 
connection process is occurring. 

o If the sensor is determined to be healthy by achieving a persistent TCP connection, the sensor 
achieves a Connected state, displaying a green tile. 

o If the sensor is determined to be unusable by refusing to connect (perhaps because it is already 
connected to another user), the sensor is assigned the Offline state, displaying a gray tile. 

o If the sensor is determined to be unhealthy because it is experiencing non-fatal errors related to 
temperature, motor velocity, or other operational parameter, the sensor is assumed to be in a state 
of Malfunction, displaying a red tile.  

Although the tile appears red, these sensors are in a Connected state and capable of collecting data 
that can be visualized, recorded, and calibrated. The diagnostics panel lists which non-fatal errors the 
sensor is experiencing.  

If a sensor experiences a fatal error while trying to connect, it immediately goes Offline (gray).  

An Ubuntu host terminal may display the error message, which would be something similar to, 
Terminating after catching exception: Firmware watchdog violation / Firmware 

version mismatch. 

2. Connect to one or more Online sensors. Be aware that connecting to a sensor secures ownership, which 
prevents any other users from connecting to it and using it. See Viewing Point Clouds — Visualize Tab 
(page 58). 

o At least one sensor must be Connected to visualize or record LIVE data. 
o At least two sensors must be Connected to perform LIVE calibration.  
o At least two sensors must be included in a recording to perform PLAYBACK calibration. 

View Sensor Tiles and States 

When the list of sensors is refreshed sensors are either. See Figure 15. Dashboard Tab: Interface. 

• Found and are auto-assigned a number that starts from one and increments for each new discovery: 
Sensor 1, Sensor 2, and so on.  

• Remembered from previous searches, retaining previous user-edited labels, such as West Roof. See 
Managing Sensors — Dashboard Tab (page 41). 

Each sensor is represented by a tile that offers an image and data that indicates its state and enables additional 
actions. See Table 9. Dashboard Tab: Sensor States and Figure 26. Dashboard Tab: Example Sensor Tile. 
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Figure 26. Dashboard Tab: Example Sensor Tile 

 

Table 9. Dashboard Tab: Sensor States 

Sensor State Visual Data  Textual Data 1 Example Tile 

EMPTY.  
Previously labeled sensor displays 
upon startup, waiting briefly for 
auto-search to find the sensor and 
reflect its state. 

Uncolored tile, green text Label, uneditable  
IP blank  
Serial # blank 

 

ONLINE.  
Auto-search or IP address search 
finds a valid sensor that appears to 
be active. 

Blue tile, white text  
Sensor image, model  
White online dot icon  
Connect (+) button 

Label, editable  
IP address  
Serial #  
Device, revision 

 

CONNECTED.  
When you click the Online sensor’s 
Connect (+) button, a persistent 
TCP connection to the sensor is 
achieved, so you now “own” it.  

Green tile, black text  
Sensor image, model  
White broadcast dot icon  
Disconnect (–) button  
Diagnostics (...) button’s 
large active area is bolder 
when hovering over it 

Label, editable  
IP address  
Serial #  
Device, revision 

 

MALFUNCTIONING. 2 
When connect attempt is made, 
the sensor does not produce any 
data, or connected sensor returns 
an error during operation.  

Red tile, white text 
Sensor image, model 
Exclamation (!) icon 
Disconnect (–) button may 
or may not appear 
Diagnostics (...) button  

Label, uneditable  
IP address 
Serial #  
Device, revision 

 

OFFLINE. (Unusable.)  
Auto-search does not find 
previously labeled sensor, or 
Online sensor won’t connect.  
Deletable by clicking X button. 

Gray tile, black text  
Sensor image  
Exclamation (!) icon Delete 
(X) button 

Label, uneditable  
Offline  
Serial #  
Device, revision 

 

Status dot, device image 

Sensor model 

Tile color shows sensor state 

Tile sorting by the same final 
6 digits as the MAC address 

Connect/Disconnect 
button 

Editable label  

IP address 

Sensor model, revision 

Diagnostics button (…) 
is here when connected 

Serial number 
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Sensor State Visual Data  Textual Data 1 Example Tile 

NOT FOUND.  
Manual search by IP address does 
not find sensor if it does not exist, 
is off the network or refuses TCP 
connection.  
Delete by clicking X button. 

Black tile, mixed colors  
Warning (∆) icon  
Delete (X) button  

Label is IP 
address, editable 
as octets  
Sensor not 
found.  

Table Notes: 
1. M8 sensors Rev D4 and below do not report device revision level. 
2. S-Series sensors do not display a Malfunctioning (red) state. 

View Sensor Tallies 

As you exercise options available on the Dashboard tab, Q-View keeps a visible running tally of sensors for the 
following categories of sensors. See Figure 15. Dashboard Tab: Interface and Figure 27. Dashboard Tab: Sensor 
Tallies. 

• Connected: Number of sensors that have achieved a persistent TCP connection with Q-View. This 
includes all sensors in a Connected (green) state and a Malfunctioning (red) state. See Table 9. 
Dashboard Tab: Sensor States. 

• Online: Number of sensors that are (or were previously) detected on the network. 

• Labeled: Number of sensors that have been given nicknames by the user. These labels are tightly 
coupled to the sensor. Even when the sensor goes Offline and later comes Online again, the last known 
user-defined label appears with it. Unless, the Offline sensor is deleted, through the Delete  button, 
then the label is forgotten.  

• Malfunction: Number of sensors that are in a Connected state, but are experiencing non-fatal errors 
related to temperature, motor velocity, or other operational parameters. The sensors, whose tiles appear 
red, are capable of connecting and collecting data that can be visualized, recorded, and calibrated. The 
diagnostics panel shows which non-fatal errors the sensor is experiencing. See Figure 30. Dashboard Tab: 
Diagnostics Panel Sensor Error. 

 
Figure 27. Dashboard Tab: Sensor Tallies 

Edit Sensor Names and Labels 

Sensors are assigned generic default names, but you can redefine those names with more meaningful labels, 
which are a handy way to identify specific sensors. Q-View has the following behaviors related to labels: 

• During automatic sensor discovery, Q-View names sensors in numeric order as they are found: Sensor 1, 
Sensor 2, and so on. 
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• Names and labels of sensors in the Offline (gray) state and Malfunctioning (red) state are not editable.  

• Names and labels are recognized locally per host computer and per user. In other words, two users on 
two separate host computers can relabel the same sensor without impacting each other experience.  

• If you type a label that is already in use, Q-View reverts to the previous label. 

To change a default Sensor X label to something more meaningful (place, owner, group...): 

1. From the Dashboard tab > Sensor tile, click the label of a sensor. 

2. Delete the old label by backspacing, or by double-clicking to highlight entire label. 

3. Type the new label, up to 12 characters. 

4. Press the Enter key, or click away from the field, to apply it. 

Handle a Malfunctioning Sensor 

Understand the specifics of a Malfunctioning (red) sensor when deciding how to handle it:  

1. Upon attempting to connect to an Online (blue) sensor, a sensor that achieves a persistent TCP 
connection is in a Connected state. However, if the sensor also returns an error code, it remains 
Connected, but in a Malfunctioning (red) state.  

A Malfunctioning sensor continues to produce useful data, except for in the case of a Motor 
Initialization Error, which stops the spinning mechanism, but could recover. 

2. Use the sensor as normal in the Q-View tabs.  

3. Click the connected Malfunctioning sensor tile Diagnostics (...) button to view the diagnostics panel, 
which reveals any error codes reported by the sensor. See Figure 28. Dashboard Tab: Diagnostics (...) 
Button and Figure 30. Dashboard Tab: Diagnostics Panel Sensor Error. 

4. For strategies for resolving minor anomalies. See Sensor is Malfunctioning (page 128). 

5. For explanations of the error codes, see the “Troubleshooting Issues” section of each Sensor User Guide.  

View the Sensor Diagnostics 

For sensors in the Connected (green) or Malfunctioning (red) state, you can view a diagnostics panel that 
reveals a variety of information about the sensor.  

How to View and Dismiss 

To view a particular sensor diagnostics data. See Figure 28. Dashboard Tab: Diagnostics (...) Button and Figure 30. 
Dashboard Tab: Diagnostics Panel Sensor Error. 
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1. Click the Diagnostics (...) button active area on the sensor tile to reveal the diagnostics panel overlay.  

2. Click the Close (X) button in the upper-right corner of the diagnostics panel to dismiss the panel and 
restore the regular Dashboard view.  

  
Figure 28. Dashboard Tab: Diagnostics (...) Button 

Diagnostics button 
active area 
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Sensor Diagnostics Panel Details 

Only one diagnostics panel appears at a time, overlaid on the list of sensor tiles. Compare the panels for sensors 
in good health and panels displaying non-fatal errors. See Figure 29. Dashboard Tab: Diagnostics Panel Healthy 
Sensor and Figure 30. Dashboard Tab: Diagnostics Panel Sensor Error. 

Note:  M8 sensors (Rev D4 and earlier) sensors do not display errors. 

 
Figure 29. Dashboard Tab: Diagnostics Panel Healthy Sensor 

 
Figure 30. Dashboard Tab: Diagnostics Panel Sensor Error 

For both healthy and malfunctioning sensors, the diagnostics panel provides several important data points.  

To make any of the adjustments suggested in the descriptions below, see each Sensor User Guide. 

• Identification: Reveals the sensor label.  

The label includes the title assigned to the sensor. For example: FrontParkLot and Entrance. The 
colored dot next to the sensor type title indicates status: green dot is online and healthy, red dot is 
malfunctioning. 

The IP address, Serial # (number), and MAC Address are specific to the sensor. 
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The Device field lists the device model and firmware version. For example: M8, Rev D4P and MQ-8-
POE, Rev 1. If the sensor diagnostics panel does not list the sensor Revision (Rev) number, check the 
physical label on the sensor or log into the sensor web server interface.  

• FOV Scan Field: Field of View Scan Field settings configured for the sensor. Where the first value is the 
FOV start angle and the second value is the FOV end angle. These are measured in degrees from 0.0 to 
360.0.  

o For setting the FOV, see the Sensor User Guide and the Sensor Web Server.  
o For viewing the FOV in a QORTEX Aware visualizer, see Connect to a QORTEX Aware Enabled Sensor 

(page 101). 
o This field is not displayed for M8 Rev D4P and earlier, or S3-2 sensors.  

• Sensor Temperature: States the numerical temperature, such as 41°C, and shows a colorful visual gauge 
ranging through green (cool), yellow, orange, and red (hot).  

• Frame Rate: States the number of cycles per second in hertz.  

o For M-Series sensors, this is the rotational speed of the turret, which is adjustable through the web 
server. See the “Edit Settings” section in the Sensor User Guide. 

o For S-Series sensors, this is the scanning speed (reaction time). 

• Model: States the model name and shows the sensor image.  

• NMEA/PPS: National Marine Electronics Association (NMEA)/Precise Positioning Service (PPS) reveals 
the GPS status. This is adjustable through the web server. See “Edit Settings” (GPS section) in the 
Q-Track Sensor User Guide. See Table 10. NMEA/PPS GPS Status Messages. 

GPS supported sensors: Q-Track ?? 

Table 10. NMEA/PPS GPS Status Messages 

Sensors NMEA/PPS Status Messages Notes  

M1 
M1 Edge 
M8 
M8-PRIME 

GPS locked A locked status requires the following criteria: 
• Sensor is attached to the NMEA/PPS inputs. 
• Internal clock is successfully trained to the GPS external 

reference (satellite).  
• Internal timebase is properly adjusted to GPS time so that the 

PPS input always arrives within 4 µs of the internally expected 
time.  

Note: M8 Rev D5 or lower 

M8  GPS unlocked Note: M8 Rev D5 or lower 

M1 
M1 Edge 
M8-PRIME 

GPS unlocked, no PPS 
detected  

 

M8-PRIME GPS lock in progress  
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Sensors NMEA/PPS Status Messages Notes  

M8-PRIME GPS locked but suboptimal 
PPS 

 

M8-PRIME GPS unlocked, noisy PPS  

M8-PRIME GPS unlocked, PPS has been 
lost  

Possible reasons include:  
• Lost a successful lock to GPS on stable/ specified PPS signal.  
• Lost a suboptimal lock to GPS on unstable/ short PPS signal. 

Q-Track LR   

Q-Track HD   

Q-Track Dome   
 

GPS unsupported sensors: M8 PoE, MQ-8 PoE, S3-2 

The GPS field for sensors that do not support GPS show the following message.  

o M8-PoE message: GPS unlocked.  
o MQ-8 PoE message: GPS unlocked, no PPS detected.  
o S3-2 message: Blank field.  

• No Error: If the sensor is not returning an error, a large green checkmark appears.  

o If the Q-Track M1, M1 Edge, M8 (Rev D4P and higher), M8-PRIME, M8 PoE+, or MQ-8 PoE+ sensor 
returns an error, a message printed in red describes the problem. Refresh the display of sensors by 
selecting the Search network  button to clear up any minor anomalies. See “Troubleshooting 
Issues” in each Sensor User Guide for possible causes and solutions for each code. See Figure 30. 
Dashboard Tab: Diagnostics Panel Sensor Error. 

o M8 sensor Rev D4 and lower can return an error but cannot report it in the diagnostics panel.  
o S-Series sensors do not return errors.  

Disconnect from a Sensor 

To disconnect from a Connected (green) sensor or a Malfunctioning (red) sensor, click the sensor tile 
Disconnect (–) button, and the sensor reverts to an Online (blue) state.  

Delete a Sensor 

To remove a sensor in the Offline (gray) or Not Found (black) state from the sensor list, click the sensor tile 
Delete (X) button, and the sensor is removed from the list. 
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 Viewing Point Clouds — Visualize Tab 
The Visualize tab allows the user to verify that a particular sensor is producing a point cloud. The point cloud is 
displayed to confirm that the sensor is perceiving what you expected it to perceive. If there are any problems, 
the point cloud can help you diagnose and address the root cause. For optimal results in visualizing point clouds, 
Quanergy recommends connecting to up to 18 sensors in single return mode. See Figure 32. Visualize Tab: 
Connect to Sensors Message. 

View the Visualize Panel 

Click the Visualize tab, .  Q-View opens the visualization panel.  

If any sensors are in a Connected (green) state, Q-View displays sensor point cloud in the visualization window. 
See Figure 31. Visualize Tab: Interface. 

 
Figure 31. Visualize Tab: Interface 

Visualize Tab 

Mode Selector 

Sensors 

XYZ Axes 

Display Selector 

Grid Size Selector 

Point Size Selector 

View Reset 
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If the panel is a blank grid with an advisory message, then zero sensors are Connected. See Figure 32. Visualize 
Tab: Connect to Sensors Message. 

 
Figure 32. Visualize Tab: Connect to Sensors Message 

Visualization Panel Components 

The Visualize tab features several interface options. See Figure 31. Visualize Tab: Interface. 

Mode Selector 

A mode selector offers a choice of displaying. See Choose LIVE or PLAYBACK Mode (page 81). 

• LIVE data that is visualized in real time. This is the default mode.  

• PLAYBACK data that was previously recorded.  

Connected Sensor Buttons 

All sensors in a Connected state appear as buttons above the visualization window. See Figure 31. Visualize Tab: 
Interface.  

• If no sensors are Connected, a message appears instead of sensor buttons: “Connect to sensors to 
visualize the point clouds”. See Figure 32. Visualize Tab: Connect to Sensors Message. 

• If one or more sensors are Connected, the first sensor button that is listed is selected by default, and its 
point cloud appears.  

• If there are more sensors than can appear in a single row, arrow heads appear at the beginning and end 
of the row to enable left and right scrolling.  

XYZ Axes 

Most of the space in the Visualize tab is devoted to displaying the point cloud of the selected sensor, and this 
space always includes XYZ axes to help orient the point cloud. See Figure 31. Visualize Tab: Interface. 

Display Selector 

The display selector offers a choice of displaying points by specific color scheme: Ring Based (default), 
Intensity, or Return. See Select a Color Scheme (page 65). 
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Grid Size Selector 

The Grid size selector offers a choice of what each side of a square grid cell represents in meters, from 1 meter 
minimum to a maximum of the sensor point cloud range. By default, the grid is set to 5 meters. The setting is 
adjustable in 1-meter increments. See Adjust the Grid Size (page 67). 

Point Size Selector 

The Point size selector adjusts each point to display as 1, 2, 3, 4, or 5 pixels (px). The larger point sizes make it 
easier to see, but at the expense of precision. See Select a Point Size (page 68).  

View Reset Buttons 

It possible to get disoriented when manipulating a point cloud. In the upper-right corner of the window, View 
Reset buttons allow you to force the point cloud to snap into easily understood Top, Side, and Perspective 
Views. See Figure 31. Visualize Tab: Interface and Reset the View (page 64). 

3D Controls 

Mouse and keyboard devices enable more precise manipulation of the point cloud. See Apply the 3D Controls 
(page 65). 

Visualize a Point Cloud 

The Visualize tab can display data collected in real time (LIVE mode) or data that was previously recorded 
(PLAYBACK mode).  

LIVE Mode 

By default, the Visualize tab displays in LIVE mode. See Figure 31. Visualize Tab: Interface. 

• If no sensors are Connected, the visualization window is empty. To populate the visualization window, 
click the Dashboard tab, connect to one or more sensors, then click the Visualize tab.  

• If one sensor is Connected, it appears as a button above the visualization window. If the button is 
selected (green), its point cloud is visualized in Top View orientation. Click the Sensor button to toggle 
its visualization on and off.  

• If multiple sensors are Connected, they appear as buttons above the visualization window, and the point 
cloud of the first sensor listed is selected (green) and visualized in Top View orientation.  

o Click the selected sensor button to toggle its visualization on and off.  
o Click the button of a different sensor to visualize its point cloud instead. The newly selected sensor 

button turns green.  

• If you notice anything odd in the point cloud, or no points are displayed, see Troubleshooting Issues (page 
127). 
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• To switch between PLAYBACK mode and LIVE mode, click the mode selector arrow in the top right 
corner to open the drop-down menu, and select LIVE or PLAYBACK. See Figure 33. Visualize Tab: Mode 
Selector Menu (left), Items (middle), File Icon (right). 

PLAYBACK Mode 

If data in the form of Quanergy proprietary QLog format has been shared with you or recorded through the 
Record Tab, you can select PLAYBACK mode to visualize up to 5 minutes of the recorded point cloud. See 
Recording Sensor Data — Record Tab (page 69). 

PLAYBACK mode is available in both the Visualize tab and Calibrate tab. Both tabs are synchronized to 
visualize the point cloud at the same place in the recording. See Figure 33. Visualize Tab: Mode Selector Menu 
(left), Items (middle), File Icon (right). 

                     
Figure 33. Visualize Tab: Mode Selector Menu (left), Items (middle), File Icon (right) 

1. In the Visualize tab, click the mode selector arrow  to open the drop-down menu, and select the 
PLAYBACK item.  

2. Click the file icon  that appears. 

3. Navigate to the directory containing the QLog data you wish to visualize. 

4. Select the directory, then click the Choose button. See Figure 34. Visualize Tab: Select Playback Data 
Directory.  

 
Figure 34. Visualize Tab: Select Playback Data Directory 
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5. If you select a directory that doesn’t have any QLog files in it, a pop up appears. See Figure 35. Visualize 
Tab: Invalid Directory Selected. 

 
Figure 35. Visualize Tab: Invalid Directory Selected 

6. When the files from a valid directory begin to download, a pop-up appears with a progress indicator and 
a button by which you can cancel the process. If you cancel the process, a confirmation window 
appears. See Figure 36. Visualize Tab: Uploading Files (left), Canceling the Upload (right). 

         
Figure 36. Visualize Tab: Uploading Files (left), Canceling the Upload (right) 

7. If you prefer to adjust the speed of the visualized recording, click the up/down arrows  to cycle 
through the options — .5 (slowest), 1.0 (default), 1.5, 2.0, 2.5, 3.0, 3.5, 4.0, 4.5, and 5.0 (fastest) — and 
select the speed you prefer. See Figure 37. Visualize Tab: PLAYBACK Play (top), Pause, Step Forward, 
Replay (bottom). 

Note:  This Speed selector disappears after the data is visualized. It reappears if 
you select pause during replay or select a different recording to visualize. 

 

 

 

 
Figure 37. Visualize Tab: PLAYBACK Play (top), Pause, Step Forward, Replay (bottom) 
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8. To visualize the data, click the Play arrow , then click one or more sensor buttons. See Figure 37. 
Visualize Tab: PLAYBACK Play (top), Pause, Step Forward, Replay (bottom). 

o The selected sensor button turns green, and the point cloud appears.  

If two or more sensor buttons are selected, the Calibrate tab becomes enabled, and you can pause 
the recording while you open the tab to calibrate a pair of recorded sensors. 

o The time indicator increments up and the ball indicator  slides forward until the visualized 
recording ends.  

o The time displays with a concluding Z to indicate Coordinated Universal Time (UTC). 

9. During play, you have two options for jumping to the approximate time you prefer to visualize. Select 
the Pause button  during play, then choose a method. See Figure 37. Visualize Tab: PLAYBACK Play 
(top), Pause, Step Forward, Replay (bottom). 

o Select and drag the ball indicator , which jumps in intervals of 100-ms. Playback pauses 
visualization at the place you select in the timeline. You can drag the ball indicator in both play and 
pause modes. 

o Click the Step Forward button  to jump ahead in intervals of 100-ms.  

10. To replay the recording after it ends, click the Replay arrow . See Figure 37. Visualize Tab: PLAYBACK 
Play (top), Pause, Step Forward, Replay (bottom). 
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Reset the View 

The View Reset buttons change the point cloud display in either LIVE or PLAYBACK mode. See Figure 38. 
Visualize Tab: Top View (left), Side View (middle), Perspective View (right). 

1. Visualize real-time or recorded data. 

2. Hover over a View Reset button to highlight it and reveal its name, then click a View Reset button to 
instantly snap back to that view: 

o The Top View (default) button displays a two-dimensional “birds-eye-view” as though looking 
straight down on the top of the sensor. 

o The Side View button displays a two-dimensional “worms-eye-view” as though looking straight out 
at the side of the sensor.  

o The Perspective View button displays a three-dimensional view as though looking from above and 
to the side of the sensor. 

 

     
Figure 38. Visualize Tab: Top View (left), Side View (middle), Perspective View (right) 

View Reset Buttons: 

Top View (default) Side View Perspective View 
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Apply the 3D Controls 

No matter which view you start with or reset to, you can always apply the 3D controls via mouse and keyboard 
to fine-tune the point cloud perspective according to your needs and preferences. 

• To rotate the point cloud around the Z-axis, hold down the left mouse button and drag left or right 
along a horizontal line. (Diagonal dragging is fine, too, but it yields results that are not as neatly 
explained.) 

• To move the perspective from birds-eye-view to worms-eye-view (subterranean view), hold down the 
left mouse button and drag up or down along a vertical line. (Diagonal dragging is fine, too, but it yields 
results that are not as neatly explained.) 

• To zoom in and out from the center of the point cloud, rotate the mouse wheel. 

• To reposition the point cloud within the visible area, press the keyboard Shift key and the left mouse 
button, then drag until the area of interest is where you want it to be.  

Note:  Touchpads are not fully supported at this time. 

Select a Color Scheme 

Select one of three color schemes listed in the display selector to highlight features in the visualized data that 
are important to you. See Figure 39. Visualize Tab: Menu for Intensity, Ring Based, and Return Color Schemes. 

Ring Based color scheme (default) helps troubleshoot issues related to a particular ring.  

• M-Series sensor points appear in a major color that represents each ring in the stacked layer: red, 
orange, yellow, green, blue, indigo, violet, magenta.  

• S-Series sensor points appear in red and cyan. 

Intensity color scheme displays points in a spectrum, as follows: 

• M1, M8 (Rev D5 and up), M8-PRIME, M8 PoE+, and MQ-8 PoE+ sensor points appear in a spectrum of 
red (least reflective), orange, yellow, green, blue, indigo (most reflective) to indicate levels of 
retroreflectivity.  

• M8 sensor Rev D4P and below do not detect intensity properly. 

• S-Series sensor points appear in a spectrum of red to indigo. 
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Return color scheme varies depending on the sensor capabilities and options. See Table 11. Visualize Tab: Color 
Scheme for Point Cloud and Figure 39. Visualize Tab: Menu for Intensity, Ring Based, and Return Color Schemes. 

• M-Series sensor points are affected by selections in the Edit Settings > Return Data Select section of 
the Sensor Settings Management (web server) application: 

o If you selected All 3 returns, an RGB (red, green, blue) scheme is used, where: 

Return 0 (Maximum) points are green. 

Return 1 (Second Strongest) points are blue. 

Return 2 (Last) points are red. 

o If you selected any other option (Return 0, Return 1, or Return 2), all points are red.  

  
Figure 39. Visualize Tab: Menu for Intensity, Ring Based, and Return Color Schemes 

 

Table 11. Visualize Tab: Color Scheme for Point Cloud 

Ring Based (default) Intensity Return 
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Adjust the Grid Size 

The point cloud is displayed on a background grid of 10x10 squares (grid cells). The grid area size is double the 
sensor total range, so if a sensor range is 50 meters, then the grid area size is 100 x 100 meters. Q-View 
accommodates sensors whose ranges vary from 10 to 200 meters. By default, the point cloud appears in Top 
View, auto-scaled to display the entire point cloud within the visualization window.  

Click the selector up and down arrows to adjust the distance represented by a square in 1-meter increments. 
1 meter is the minimum size, 5 meters is the default size, and 50 meters is the maximum size. See Figure 40. 
Visualize Tab: Grid Size Selection. 

Note:  M-Series sensors do not report their ranges to Q-View, so the application 
uses a default range of 50 meters to draw the grid for those sensors. Contact 
support@quanergy.com if you need more specific configuration. 

   
Figure 40. Visualize Tab: Grid Size Selection 

mailto:support@quanergy.com?subject=Support%20M-Series%20in%20Q-View


Q-View User Guide 
 
 

 

©2024 Quanergy Solutions, Inc Q-Vew User Guide, QPN 96-00015 Rev M Page 68 

Select a Point Size 

Adjust the size of the visualized points, where each point is 1-5 pixels. Larger point sizes make it easier to see 
(especially outdoors in bright ambient light) but sacrifice precision. See Figure 41. Visualize Tab: Point Size 
Selection.  

1. Click the up or down Point size arrows to display each point in the point cloud in the preferred pixel 
size, where 1 pixel is the default.  

2. Readjust the Point size selector at any time until the display is satisfactory. 

 
Figure 41. Visualize Tab: Point Size Selection 
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 Recording Sensor Data — Record Tab 
A data recorder allows you to control simultaneous recordings of data collected by up to 18 LiDAR sensors. This 
Q-View recorder saves direct point cloud output in Quanergy proprietary QLog format, which is easily exported 
to other formats, including PCD and LAS.  

View the Record Panel 

Click the Record tab, . Q-View displays the Recorder panel. See Figure 42. Record Tab: Recorder Interface.  

 
Figure 42. Record Tab: Recorder Interface 

In addition to the active/inactive color options for Q-View tabs, the Recorder tab also indicates when Q-View is 
in PLAYBACK mode (for the Visualize tab and Calibrate tab). The Record tab is disabled, and its icon changes to 
a dim gray color. 

                          
Figure 43. Record Tab: Appearance and Status 

Record Tab Recorder Controls Area Sensor Selection Area Export Button 

Enabled Activated Disabled 
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Record Panel Components 

The Record tab divides into three main areas. See Figure 42. Record Tab: Recorder Interface.  

• Recorder Controls. See Figure 44. Record Tab: Recorder Controls: Sensor Selected (top), Recording (bottom). 

• Sensor Selection. See Figure 46. Record Tab: Sensor Selection Area: Connected, Selected, Recorded. 

• EXPORT Button. See Figure 47. Record Tab: QLog Export with Combined Sensors Option. 

Recorder Controls 

The recorder controls area includes several interface components. See Figure 44. Record Tab: Recorder Controls: 
Sensor Selected (top), Recording (bottom). 

 

 

 
Figure 44. Record Tab: Recorder Controls: Sensor Selected (top), Recording (bottom) 

• START/STOP Button. A toggle button waits, initiates, or ends recording activity: 

o At first, the START button is gray to indicate no sensors are available to record. 
o After sensor(s) have been selected through the Dashboard tab and Sensor Selection area, the 

START button inner dot becomes red to indicate readiness. 
o After the START button is clicked, it becomes a red STOP button by which to end the recording 

activity.  
o Once the STOP button is selected, the recording process stops, and the button is ready to START 

again.  

• Time Counter. While a recording is active, a counter indicates how long a recording has continued, using 
the format HH:MM:SS.TTT to represent incrementing hours, minutes, seconds, and microseconds 
(T=1/1000 seconds).  

• Size Counter. While a recording is active, a Recorded Data counter indicates the increasing size of the 
recording in megabytes (MB) of data. 

Compression Button 

Duration Limiter 

Browser Button 

Filepath Size Counter Time Counter 

START/STOP Button 



Q-View User Guide 
 
 

 

©2024 Quanergy Solutions, Inc Q-Vew User Guide, QPN 96-00015 Rev M Page 71 

• Filepath and Browser Button. Specify where the data recording is stored.  

a. Enter the filepath in the Output Directory field. Use English alphanumeric characters only! 

b. Click the ellipsis ... icon to open a browser, then navigate to the preferred directory (or create a new 
directory). Default filepaths: 

For Ubuntu: ~/ home directory  

For Windows: C:\Users\<username> directory  

• Duration Limiter. A numeric Maximum Log File Duration control allows you to select and type or to 
click the up/down arrows to limit the duration of the individual log files, from a 1-minute minimum to a 
999-minute maximum. Each time the duration limit is reached, a new file is saved as q00, then q01, 
q02.... 5 minutes is the default length.  

• Compression Button. The data Compression button allows you to click ON to make file sizes as small as 
possible (lossless compression) or OFF to record files of regular size. 

As a result of your interaction with these recorder controls, during a recording event, a new directory is created 
with a unique name based on a timestamp: YYYY-MM-DD_HH-MM-SS.TTT  (year-month-day_hour-minute-
second.microsecond).  

The actual QLog data files and a sensor_settings.xml file are placed in the output directory. Each QLog data 
file is named <sensorname>.q00, where q00 increments for each sensor (q01, q02, and so on). See Figure 45. 
Record Tab: Produces sensor_settings.xml File. 

-<Settings> 

 -<Sensors> 

  -<Lidar> 

   <name>Garage</name> 

   <ip>10.1.11.142</ip> 

   <port>4141</port> 

   </Lidar> 

  </Sensors> 

 -<Transforms> 

  -<Transform> 

   <fromFrameName>Garage</fromFrameName> 

   <toFrameName>Body</toFrameName> 

  -<Position> 

   <x>1.0309906/x> 

   <y>3.05418968</y> 

   <z>8.458936735</z> 

   </Position> 

   <orientationMethod>quaternion</orientationMethod> 

  -<Quaternion> 

   <w>0.140181616</w> 

   <x>0.021026712</x> 
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   <y>0.0542631559</y> 

   <z>0.988414168</x> 

   </Quaternion> 

  -<EulerYPR> 

   <units<degrees</units> 

   <yaw>164.02146911621094</yaw> 

   <pitch>3.2549090385437012</pitch> 

   <roll>-5.82773311325073242</roll> 

   </EulerYPR> 

   </Transform> 

  </Transforms> 

</Settings> 

Figure 45. Record Tab: Produces sensor_settings.xml File 

Select Sensors for a Recording Event 

For optimal results when recording visualized point clouds, Quanergy recommends connecting to up to 
18 sensors in single return mode. The Sensor Selection area lists a checkbox for each of those connected 
sensors. Check up to four of the listed sensors for inclusion in the recording event. See Figure 46. Record Tab: 
Sensor Selection Area: Connected, Selected, Recorded. 

Note:  The sensors do not have to be calibrated because the data streams are 
completely independent and unfused.  

The Sensor Selection area varies in appearance depending on whether the listed sensors are connected, 
selected, or recorded. 

     
Figure 46. Record Tab: Sensor Selection Area: Connected, Selected, Recorded 

Select EXPORT Parameters  

1. From the Recorder panel, click the EXPORT button.  

2. Select options in the Export panel. Then click Start. 

This panel provides various fields and menus for specifying the export parameters. See Table 12. Export 
Button Parameters, Figure 42. Record Tab: Recorder Interface and Figure 47. Record Tab: QLog Export with 
Combined Sensors Option. 

Connected Sensor Selected Sensor Sensor Being Recorded 
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Table 12. Export Button Parameters 

Parameter Description 

QLog File:  Filepath to where the recorded file was placed. 

Output Directory:  Filepath to where the exported file will be placed. 

Filename Prefix:  cloud (default) or type any preferred prefix. 

File Format:  Options are PCD (default) and LAS. 

Precision:  Enabled is available only for LAS: decimeter, centimeter, millimeter, micrometer. 

Compress:  Enabled (lossless compression) is available only for LAS, but the default is unchecked 
(uncompressed). 

 

Record Data File in QLog Format 

If one or more sensors are in a Connected state, then you can record their point cloud data from the Record tab 
Recorder interface. See Figure 42. Record Tab: Recorder Interface, Figure 44. Record Tab: Recorder Controls: Sensor 
Selected (top), Recording (bottom), Figure 46. Record Tab: Sensor Selection Area: Connected, Selected, Recorded, and 
Figure 48. Record Tab: Output Directory: Settings & Exported Files, QLog, PCD Format. 

1. In the Sensor Selection area, check the box for each sensor (up to four) that you wish to record. 

2. In the Output Directory field, specify a local filepath to where data will be stored.  

3. In the Maximum Log File Duration field, type or click the increment buttons to specify the maximum 
length of the recording in whole minutes.  

4. Toggle the Compression button ON or OFF for data compression. 

5. Click the START button to begin the recording.  

6. Monitor the time and size counters, if you wish to make an informed decision about whether and when 
to click the STOP button to end the recording before it reaches the maximum duration.  

7. Find the QLog file where it is placed in the output directory along with a sensor_settings.xml file.  
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Export Recorded QLog File to Another Format 

Recorded QLog data can be exported to Point Cloud Data (PCD) and LASer (LAS) format. QLog data can be 
from a single sensor or multiple sensors. Multiple sensor data stored in a single folder is combined and exported 
into a single file of the selected type. 

1. From Q-View left panel, select Record, click EXPORT. 

2. Complete the QLog Export form. See Figure 47. Record Tab: QLog Export with Combined Sensors Option. 

a. Select the sensor to source. In the PCD Output Type field, select either Single Sensor or 
Combined Sensor.  

If Combined Sensor is selected, enter a path and filename or browse (ellipsis (...) icon) to a 
Calibration File. This can be QLog data from either Q-View or QORTEX DTC. For example: 

  datasets/Recordings_M8/2019-11-11_09-44-35.799/settings.orig.xml 

b. Select the QLog content for exporting. In the QLog File/Folder field, enter or browse (ellipsis (...) 
icon) to locate the data.   

▪ For a Single Sensor, select a single QLog. 
▪ For Combined Sensor export, select the directory that contains the QLog files of all the sensors 

in your environment. For example. 

  datasets/Recordings_M8/2019-11-11_09-44-35.799/ 

c. Select the directory to save the exported file. In the Output Directory field, enter or browse (ellipsis 
(...) icon) to specify the target location. For example. 

  /home/username/pcd/ 

d. Optionally, edit the Filename Prefix field. The default is cloud. 

e. Select the file format. From the File Format drop-down menu, select either PCD or LAS.  

If exporting to LAS format: 

▪ Select a metric unit from the Precision drop-down menu.  
▪ For compressed data, check the Compress box.  

3. Click the START button to begin exporting the designated file into the output directory.  

o The START button changes to a STOP button and a message appears at the bottom of the dialog 
box, such as: “Exporting Point Cloud Data 79% Complete.”  

o The message updates to “Export completed successfully!” when the process ends.  
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4. Find the exported files in the output directory. See Figure 48. Record Tab: Output Directory: Settings & 
Exported Files, QLog, PCD Format. 

Note:  LAS files include a timestamp that is in GPS time whether the sensor is 
connected to GPS or not.  

 
Figure 47. Record Tab: QLog Export with Combined Sensors Option 

 
Figure 48. Record Tab: Output Directory: Settings & Exported Files, QLog, PCD Format 

 

Created Sensor Settings File 

Recorded QLog File 

Default Prefix 

Exported Files in PCD Format 
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 Calibrating Sensors — Calibrate Tab 
The Calibrate tab enables production of a file containing sensor calibration parameters that can be used by 
other applications. Through this tab, the user aligns multiple sensors in LIVE or PLAYBACK mode so they share 
the same QORTEX “world frame,” that is, have the same XYZ orientation and (0, 0, 0) point of World Origin from 
which to calculate an object location. In this way, point clouds (and tracked objects) overlap to provide a richer 
and broader view of the shared physical space called the area of interest. See Figure 49. Calibrate Tab: Interface. 

Often, the Origin of one sensor in a group will serve as the QORTEX World Origin. For example, in an area of 
interest that includes contiguous surveilled spaces (front parking lot, lobby, research lab, snack room, rear exit, 
and back lot), the Origin could be a sensor in the middle (research lab, for example). However, it is not necessary 
for a sensor to serve as the World Origin because any location in the coverage area of the QORTEX server will 
do.  

Such calibration is therefore possible between sensors that are: 

• In a common area of interest, where their point clouds overlap at least partially.  

• M-Series models, so you can mix and match them. The Refine auto-alignment option is only supported 
for calibration between two of the same type of sensors. For example, calibration between two M8 
sensors or two MQ-8 sensors. For any other combination of sensors, users can only make manual 
refinement adjustments. 

• Either in LIVE mode in a Connected (green) state or a Malfunctioning (red) state, or in PLAYBACK 
mode. For optimal results in visualizing point clouds, Quanergy recommends connecting to up to 
18 sensors in single return mode. 
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View the Calibrate Panel 

Click the Calibrate tab, . Q-View displays the calibrate a sensor panel. See Figure 49. Calibrate Tab: Interface, 
Figure 50. Calibrate Tab: Context Controls, and Table 13. Calibrate Tab: Interface Components.  

For descriptions of the Mode Selector menu (LIVE, PLAYBACK), Grid size arrows, Point size arrows, View 
Reset buttons, and XYZ axes are also part of the Visualize tab. See Visualization Panel Components (page 59). 

 
 

 
Figure 49. Calibrate Tab: Interface 

Calibrate Tab XYZ Axes 
Context Buttons 

Context Icons 

Instructions Mode Selector Menu 

View Reset 
Sensor Buttons 

Grid Size Point Size Grid Area Size 
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Calibration Panel Components 

For descriptions of the Calibrate tab interface components, see Figure 50. Calibrate Tab: Context Controls, Table 
13. Calibrate Tab: Interface Components. 

Table 13. Calibrate Tab: Interface Components 

Component Location Purpose 

Mode Selector 
Menu 

Top left corner Click the menu arrow and select a mode:  
LIVE: Mode for calibrating according to real-time data (default). See LIVE 
Mode (page 60). 
PLAYBACK: Mode for calibrating according to recorded data. See 
PLAYBACK Mode (page 61).  

Instructions Upper side ribbon  Simple commands guide you through each step of the process. 

Sensor Buttons Top of right-side 
navigation bar 

Individual sensors appear as selectable buttons, arranged in rows. Each 
button has a colored dot to indicate its status: selected (green), non-selected 
(red), or calibrated (white) status. Disconnected calibrated sensors have a 
gray button.  

Grid Area Size  Top right corner  Adjust the grid area (canvas) size arrows to match the size of the area of 
interest (1m-50m).  

Grid Size  Top right corner  Adjust the grid size (density) arrows so that grid lines are closer together or 
farther apart. The meters indicate the distance represented by the side of a 
grid square (1m-50m). See Adjust the Grid Size (page 67).  

Point Size  Top right corner  Click the incrementing up/down arrows to select the pixel size (1-5) of each 
point in the visualized cloud. See Select a Point Size (page 68). 

View Reset 
Buttons 

Top right corner Snap the point cloud into easily understood top, side, and perspective views. 
See Reset the View (page 64). 

XYZ Axes Central grid Represents the sensor origin in the area where point clouds are visualized. 
Select a sensor to visualize its point cloud. 

Context Buttons Bottom of right-
side navigation 
bar 

Buttons brighten to prompt you to make decisions during calibration: 
Next arrow: Click when satisfied to proceed to the next step. 
Back arrow: Click to revert to a previous step.  
Undo: Click to revert a process.  
Cancel: Click to stop a process.  
Refine: Click to start auto-alignment. This process is only supported for 
calibrating two M8 model sensors to each other. 
Accept: Click when satisfied with alignment to complete/save calibration 
data. 
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Component Location Purpose 

Context Icons Right of right-side 
navigation bar 

Icons brighten to prompt you to make decisions about the calibration: 
World Calibration: Click when ready to calibrate selected sensor. See Use 
the World Calibration Controls (page 79). 
Play/Pause: Toggles between a dynamic versus static point cloud. 
New: Click to identify the base directory for a new calibration file. 
Open: Click to open the enclosing folder of an existing calibration file. 
Save: Click to save current calibration and continue calibration. 
Remove: Click if you want to abort the current calibration file and restart. 
Fused Cloud: Toggle to fuse point clouds. Toggle to distinguish sensor 
points. 

TRANSLATE 
Controls 

Right-side 
navigation bar 

See Use the World Calibration Controls (page 79). 

ROTATION 
Controls 

Right-side 
navigation bar 

These controls rotate the point cloud around the X, Y, and Z axes. See Use 
the World Calibration Controls (page 79). 

3D Controls Offline 
accessories 

Mouse and keyboard devices enable manipulation of the point cloud. See 
Apply the 3D Controls (page 65). 

Use the World Calibration Controls 

World calibration refers to the world of a sensor or calibrating a sensor to the fused point cloud of a calibrated 
group of sensors. In this context, Blue Z axis is Yaw. Green Y axis is Pitch. Red X axis is Roll. 

During the manual adjustment phases of the calibration process you might need to use TRANSLATE and 
ROTATION controls. See Figure 50. Calibrate Tab: Context Controls. 

• The TRANSLATE controls adjust the movement along each axis with respect to the Origin point in 
coarse (1 meter) or fine (1 centimeter) movements.  

• The ROTATION controls adjust the rotational movement around each axis in coarse (1 degree) or fine 
(0.1 degree) increments and decrements.  

There are two ways to adjust the settings: 

• Click the + or – (increment and decrement) buttons to scroll through numbers slowly. 

• Hover the mouse pointer over a number field and spin the mouse wheel to scroll through the numbers 
quickly. 

Point clouds are visualized in active mode. Pause the frame using the Play/Pause context icon while you apply 
adjustments to the calibration. When you toggle back to active mode, the visualization jumps to current real 
time instead of playing the frames you missed. 
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Figure 50. Calibrate Tab: Context Controls 

Create and Update a Fused Point Cloud  

Multiple sensors that are out of sight and distance range of each other can be aligned together as long as an 
individual sensor point cloud overlaps with the point cloud of at least one other sensor in that group or with the 
fused point cloud. The process for calibration of multi-sensor complex installations has been simplified to make 
it easier to create and update a fused point cloud.  

Calibration occurs through a combination of automated and manual steps to map the relationship of each 
sensor in a group to every other sensor in that group. Alignment of a single sensor to another single sensor is a 
necessary first step. After that first step, the resulting point cloud can then be calibrated to a new sensor. The 
main procedures are summarized below and overviewed in the calibration flow chart. See Figure 51. Calibrate 
Tab: Calibration Flow Chart.   

1. Choose LIVE or PLAYBACK Mode (page 81). 

2. Assign or Identify Location of Calibration Data Files (page 82).  

3. Calibrate the World of the First Sensor (page 83).  

4. Calibrate a Second Sensor to the First Sensor World (page 86). 

5. Make Changes to a Calibrated Group of Sensors (page 91).  

World Calibration 

Play/Pause (toggle) 

New 

Open 

Save 

Remove (trash) 

Fused Cloud 

Coarse/Fine Unit Selector 

Increment (increase) 

Back 

Next 

Increment (decrease) 
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Figure 51. Calibrate Tab: Calibration Flow Chart 

Choose LIVE or PLAYBACK Mode 

Calibration can occur with sensors that are collecting points LIVE or have already collected points in a recording 
for PLAYBACK.  

In the Calibrate tab, use the Mode Selector menu and select LIVE or PLAYBACK. See Figure 49. Calibrate Tab: 
Interface.  

• LIVE mode: Connect at least two sensors in the Dashboard tab. 

• PLAYBACK mode: If the recording is brief, start the playback point cloud then pause it while you 
continue with the calibration. See PLAYBACK Mode (page 61). 
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Assign or Identify Location of Calibration Data Files 

Q-View needs a clear understanding of where to find and place calibration data files, as follows: 

1. Determine where to save the calibration data files, including transform_alignment.xml and 
calibration.ini. See transform_alignment.xml File (page 93), calibration.ini File (page 95), and Figure 52. 
Calibrate Tab: Where to Store Calibration Files.   

To create a new calibration folder:  

a. Click the File  icon on the right-side ribbon to open a dialog. 

b. In the Directory Path field, type the base directory filepath.  

Alternatively, click the ellipsis ... icon to open a file browser, navigate to the base directory, and click 
Choose. 

c. In the Input Name field, type a meaningful name for the new calibration folder. 

d. Click OK in the dialog.  

The dialog disappears, the file path now appears above the sensor buttons, and the instruction 
ribbon states the next instruction. 

To add calibration data to a previously created folder: 

a. Click the Folder  icon on the right-side ribbon to open a file browser. 

b. Navigate to the enclosing folder. 

c. Select the file browser Choose button. 

  
Figure 52. Calibrate Tab: Where to Store Calibration Files 

2. Click the Next  button (right arrow) to start the calibration process.  

Context buttons are in the bottom right corner of the Q-View window. 
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Calibrate the World of the First Sensor 

The first sensor is important in that it determines the World Origin point. It may be easier to start with 
whichever sensor is most complicated, that is, not level. The steps for selecting and aligning the first sensor to 
the grid are as follows: 

1. Choose LIVE or PLAYBACK Mode. See Choose LIVE or PLAYBACK Mode (page 81). 

2. Assign or identify Location of Calibration Data Files. See Assign or Identify Location of Calibration Data 
Files (page 82).  

3. Click a sensor button to select the first sensor.  

The red dot on the selected sensor button turns green and the point cloud for the sensor appears in 
white. See Figure 53. Calibrate Tab: First Sensor White Point Cloud. 

      
Figure 53. Calibrate Tab: First Sensor White Point Cloud 

4. Click the Next  button (right arrow).  

The context icons change to a subset of the Calibration tab Context Controls. See Figure 50. Calibrate 
Tab: Context Controls. 

5. Click the World Calibration  icon to enter World Calibration mode.  

See Figure 50. Calibrate Tab: Context Controls and Use the World Calibration Controls (page 79). 

Calibration is an iterative process that varies from situation to situation. Continue with the 
recommended sequence below, customizing as needed for your specific setup.  
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6. Examine the point cloud of your selected sensor. Notice where ground points show up in concentric 
rings. See Figure 54. Calibrate Tab: First Sensor Align XY to Grid, Before (top), After (bottom). 

o The goal is for Origin and all ground points to be on/above the ground plane. 
o The ground plane is the single gray horizontal grid line in the Side View. 

7. Click the Top View button to see how XY axes align with respect to the grid. See Figure 54. Calibrate 
Tab: First Sensor Align XY to Grid, Before (top), After (bottom). 

8. Adjust the point cloud Yaw values so that the perpendicular walls in the location square up to the grid.  

 
Figure 54. Calibrate Tab: First Sensor Align XY to Grid, Before (top), After (bottom) 

9. Click the Side View button to assess the point cloud Y axis alignment with respect to the ground plane. 
See Figure 55. Calibrate Tab: Align Z to Ground Plane, Before (top), After (bottom). 
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o Adjust the Z Axis to raise/lower the entire point cloud until the concentric ring ground points are on 
or just above the ground plane. 

o Adjust the Pitch to square up the entire point cloud to the ground plane. 

10. Stay in the Side View but use your mouse to spin the view around the Z axis to see how the ground 
points touch the ground when seen from various angles. Make any additional adjustments. 

11. Click Accept to lock in the results. See Figure 55. Calibrate Tab: Align Z to Ground Plane, Before (top), After 
(bottom). 

 
Figure 55. Calibrate Tab: Align Z to Ground Plane, Before (top), After (bottom) 
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Calibrate a Second Sensor to the First Sensor World 

The first sensor world is now calibrated. To achieve a fused point cloud, at least one more sensor needs to be 
calibrated to the first sensor world, as follows: 

1. Click a Second Sensor button to calibrate it to the first sensor. The second sensor has a green point 
cloud, which is overlaid on the First Sensor white point cloud. See Figure 56. Calibrate Tab: Second Sensor 
(green) Calibrate to First Sensor (white). 

2. Examine the visualized image of the two-point clouds to make sure the sensors you selected to calibrate 
share the same area of interest.  

o If the sensors do not reflect the same area of interest, and do not track the same moving objects, 
click a different sensor.  

Click multiple sensors to compare them, then re-click the sensors you don’t want to calibrate. 
Continue this procedure with one sensor selected. 

o If the point clouds have at least a section that has the same shape and contours, and they track the 
same moving objects, then this confirms that they share the same area of interest. 

3. Focus on some points of reference that represent the same artifact in physical reality, such as the right-
angled corners.  

The goal is for the two-point clouds to align so precisely that the overlapping portions look like a single 
point cloud when viewed from every perspective. See Figure 53. Calibrate Tab: First Sensor White Point 
Cloud. 

4. Click the Next  button (right arrow).  

 
Figure 56. Calibrate Tab: Second Sensor (green) Calibrate to First Sensor (white) 
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5. Click the Top View button to see how the point cloud XY axes align with respect to the grid. See Figure 
57. Calibrate Tab: Second Sensor Align XY to Grid, Before (top), After (bottom).  

a. Adjust the point cloud Yaw to rotate the second sensor green point cloud to align with the primary 
sensor point cloud, that is, be oriented in the same direction, even if it is still offset. 

b. Adjust the X axis to move the entire point cloud forward or back, and the Y axis to move the entire 
point cloud left or right until the point clouds look perfectly overlapped, with no offset. 

 

 
Figure 57. Calibrate Tab: Second Sensor Align XY to Grid, Before (top), After (bottom) 
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6. Click the Side View button to see how the point cloud Y axis aligns with respect to the gray line of the 
ground plane. See Figure 58. Calibrate Tab: Second Sensor Align Z with Ground Plane. 

o Adjust the Z axis to raise/lower the entire green point cloud until the concentric ring ground points 
are on or just above the ground plane. 

o Adjust the Pitch and Roll to square up the entire point cloud to the primary sensor and the ground 
plane. 

7. When you are satisfied that the ground points are touching the ground plane, stay in Side-View, but 
spin the point cloud around the Z axis to see how the ground points touch the ground when seen from 
various angles. 

 
Figure 58. Calibrate Tab: Second Sensor Align Z with Ground Plane 

8. Click Perspective View, check more angles, and make more adjustments. See Figure 59. Calibrate Tab: 
Final Check in Perspective View. 

9. Optionally, for M8-to-M8 calibration: click the Refine button for final algorithmic refinement. See Figure 
59. Calibrate Tab: Final Check in Perspective View. 

A spinner  indicates auto-alignment is occurring.  

Click Undo if you don’t like the refinement results. 
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10. Click the Accept button to lock in the results. See Figure 59. Calibrate Tab: Final Check in Perspective 
View. 

The entire point cloud turns white in the fused cloud, no longer differentiating which points belong to 
which sensor. The sensor button colored dot is now white to indicate its calibrated state. 

 
Figure 59. Calibrate Tab: Final Check in Perspective View 
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11. Click the Save  icon to save the calibration data in the folder that was identified previously. See Figure 
60. Calibrate Tab: Fused Cloud Icon Consolidates into Single White Point Cloud. 

 
Figure 60. Calibrate Tab: Fused Cloud Icon Consolidates into Single White Point Cloud 

12. Click the Fused Cloud  icon to toggle the sensor view as you prefer: 

o A fused cloud, where all points turn white. See Figure 60. Calibrate Tab: Fused Cloud Icon Consolidates 
into Single White Point Cloud. 

o A differentiated cloud, where sensor buttons are outlined in the color of their visualized points, 
making it easier to spot an incorrectly calibrated sensor. See Figure 61. Calibrate Tab: Fused Cloud Icon 
Colors Points for Each Sensor. 

13. To add another sensor to the calibrated group right away.  

a. Click the Calibrate Another Sensor button. See Figure 61. Calibrate Tab: Fused Cloud Icon Colors 
Points for Each Sensor. 

b. Repeat the steps in this procedure.  
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From now on the fused cloud appears in a dynamically assigned random color. 

 
Figure 61. Calibrate Tab: Fused Cloud Icon Colors Points for Each Sensor 

Make Changes to a Calibrated Group of Sensors 

After calibration is completed, and the calibration data is saved. You can make various modifications for the 
entire group of sensors represented in the multi-sensor fused point cloud (the calibrated group). See Use the 
Results (page 93). 

1. Choose LIVE or PLAYBACK mode. See Choose LIVE or PLAYBACK Mode (page 81).  

o For LIVE mode, you will need to open the Dashboard tab and connect to all of the sensors known to 
be in the calibrated group.  

o For PLAYBACK mode, select a recorded QLog that includes all of the sensors known to be in the 
calibrated group. 

2. Click the Open Calibration button that activated as soon as at least two of the group sensors were 
selected and navigate to the location of the target calibrated group saved calibration data. See Assign or 
Identify Location of Calibration Data Files (page 82). 

3. In the Calibrate tab, select the Sensor button of each sensor in the calibrated group.  

Q-View automatically selects and connects to the remaining sensors in the calibrated group. But if it is 
not possible to select one or more sensors in the calibrated group, a warning message displays to let you 
know that not all the sensors are selected. 
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4. Click the Fused Cloud  icon to toggle the single combined color versus each sensor showing points in 
a different color. 

By default, the fused point cloud appears in a single dynamically assigned random color in the 
visualization window. 

5. From here, you can take a variety of actions: 

o Delete a sensor from the calibrated group:  

1) Select the Edit a Calibration button. 
2) Select the Remove  icon, which deletes the sensor from the group.  
3) Leave the sensor deleted or recalibrate it to re-add it to the group.  

o Refine the calibration of a sensor:  

1) Select the Edit a Calibration button. 
2) Select the Refine button, which shows the current fused point cloud overlaid with the current 

point cloud for that sensor.  
3) Adjust the X, Y, Z, Yaw, Pitch, and Roll values. See Use the World Calibration Controls (page 79). 

o Add the deleted sensors or additional new sensors to the calibrated group one at a time according to 
the steps of the “Calibrate a Second Sensor to the First Sensor World” procedure, starting on page 
76, for each sensor you want to add. 

o Adjust the world transform for the calibrated group of sensors.  

1) Select the World Calibration  icon to open controls.  
2) Adjust the X, Y, Z, Yaw, Pitch, and Roll values. See Use the World Calibration Controls (page 79).  

6. Click Accept to lock in the results. See Figure 59. Calibrate Tab: Final Check in Perspective View.  

The entire point cloud turns the solid color of the fused cloud, no longer differentiating which points 
belong to which sensor. Toggle the Fused Cloud  icon to split the sensor point clouds. 

7. Click Save  to save the calibration data.  

The data is saved in the folder that was previously defined. See Assign or Identify Location of Calibration 
Data Files (page 82). 
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Use the Results 

Each time you Accept the calibration adjustments, the resulting calibration data is output into a few files: 
transform_alignment.xml and calibration.ini. Both the files reside in the folder that was previously 
defined. See Assign or Identify Location of Calibration Data Files (page 82). 

Another file, quanergy.qview.calibration, provides a list of the Q-View configuration settings for each 
sensor. This file resides in: 

• For Windows: C:\Users\<quser>\AppData\Roaming 

• For Ubuntu: \home\<user>\.config 

transform_alignment.xml File 

Q-View creates an alignment map and saves it in a transform_alignment.xml file. Q-View uses this map to 
persist the alignment data in between sessions. See Figure 62. Calibrate Tab: transform_alignment.xml File.  

In this file, each mapping relationship is recorded only once: 

• For 2 sensors, only 1 mapping is needed. (2 --> 1) 

• For 3 sensors, 3 mappings are needed. (3 --> 2+1) 

• For 4 sensors, 6 mappings are needed. (4 --> 3+2+1) 

• For 5 sensors, 10 mappings are needed. (5 --> 4+3+2+1) 

The XML file consists of: 

• The Transform list, which defines the spatial relationship between two sensors. 

• The Lidar list, which defines the IP and MAC addresses of the two sensors. 



Q-View User Guide 
 
 

 

©2024 Quanergy Solutions, Inc Q-Vew User Guide, QPN 96-00015 Rev M Page 94 

-<Settings> 

 -<Transforms> 

  -<Transform> 

   <fromFrameName>Sensor 15</fromFrameName> 

   <toFrameName>Sensor 16</toFrameName> 

  -<Position> 

   <x>1.0309906/x> 

   <y>3.05418968</y> 

   <z>8.458936735</z> 

   </Position> 

   <orientationMethod>quaternion</orientationMethod> 

  -<Quaternion> 

   <w>0.140181616</w> 

   <x>0.021026712</x> 

   <y>0.0542631559</y> 

   <z>0.988414168</x> 

   </Quaternion> 

  -<EulerYPR> 

   <units<degrees</units> 

   <yaw>164.02146911621094</yaw> 

   <pitch>3.2549090385437012</pitch> 

   <roll>-5.82773311325073242</roll> 

   </EulerYPR> 

   </Transform> 

  </Transforms> 

 -<LidarInfo> 

  -<Lidar> 

   <frameName>Sensor 16</frameName> 

   <ip>10.1.10.128</ip> 

   <mac>D4:C9:B2:00:08:67</mac> 

   </Lidar> 

  -<Lidar> 

   <frameName>Sensor 15</frameName> 

   <ip>10.1.10.96</ip> 

   <mac>D4:C9:B2:00:11:65</mac> 

   </Lidar> 

 </LidarInfo> 

</Settings> 

Figure 62. Calibrate Tab: transform_alignment.xml File 
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calibration.ini File 

Q-View creates a calibration map and saves it in a calibration.ini file. This file is useful only to a particular 
Quanergy application, and we show it here only because it is Q-View output. See Figure 63. Calibrate Tab: 
calibration.ini File.  

[D4:C9:B2:00:11:65/D4:C9:B2:00:08:67] 

primary_ip_address=10.1.10.96 

primary_mac_address=D4:C9:B2:00:11:65 

secondary_ip_address=10.1.10.128 

secondary_mac_address=D4:C9:B2:00:08:67 

qguard_yaw=163.689453 

qguard_pitch=5.81829834 

qguard_roll=3.27178264 

qguard_x=-3.58999991 

qguard_y=1.61999929 

qguard_z=-8.14999962 

[D4:C9:B2:00:08:67/D4:C9:B2:00:11:65] 

primary_ip_address=10.1.10.128 

primary_mac_address=D4:C9:B2:00:08:67 

secondary_ip_address=10.1.10.96 

secondary_mac_address=D4:C9:B2:00:11:65 

qguard_yaw=163.942032 

qguard_pitch=-6.49773264 

qguard_roll=1.5197717 

qguard_x=-3.05418968 

qguard_y=1.0309906 

qguard_z=8.45836735 

Figure 63. Calibrate Tab: calibration.ini File 

Edit quanergy.qview.calibration File 

Edit the calibration file to modify the XY offset maximum value.  

1. Locate the directory for the calibration file. Default locations are: 

For Windows: C:\Users\<quser>\AppData\Roaming 

For Ubuntu: \home\<user>\.config 

2. Open the quanergy.qview.calibration file for editing. 

3. Change the value for the parameter, calibration_xy_offset_range.  

The default value is 500. The maximum range is 5000.  

… 

[calibration] 
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Calibration_directory=C:/Users/quser/Quanergy 

Calibration_xy_offset_range=500 

… 

4. Save the file.  

5. Restart Q-View to apply the changes. 
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 Object Detection — QORTEX Aware™ Tab 
QORTEX Aware is an object detection and notification component of the QORTEX suite for selected sensors. 
QORTEX Aware provides a means to define zones, detect objects in those zones, and send messages to listening 
devices. See Figure 64. QORTEX Aware: Components and their Function. 

Listening devices are typically controllers on mobile platforms such as Automated Guided Vehicles (AGVs) or 
Autonomous Mobile Robot (AMR), but they can also be stationary devices. The information received allows the 
devices to respond appropriately when an object has entered the defined zone.  

QORTEX Aware is pre-installed on the sensor. The sensors provide the point cloud data for QORTEX Aware to 
interpret and identify objects in the defined zones. 

QORTEX Aware always uses a single return from each laser pulse, regardless of sensor webserver setting. 

• If a single return is selected, QORTEX Aware uses that return 

• If all returns are selected QORTEX aware uses the max return (return 0). Q-View shows all returns.  

QORTEX Aware elements are configured through the Q-View user interface. Configuration is uploaded to the 
sensors. Q-View is a graphical interface tool for configuration and visualization. Q-View is installed on a 
networked laptop. QORTEX Aware messages travel through the Ethernet on the sensor.  

 

 
Figure 64. QORTEX Aware: Components and their Function 
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QORTEX Aware Q-View Version Compatibility 

Q-View 1.7 is NOT backwards-compatible with sensors running Qortex Aware 1.0 (M1 Edge sensors). 

Table 14. QORTEX Aware to Q-View Version Compatibility 

Q-View Version Qortex Aware Version 

1.6 1.0 

1.7 2.0 

QORTEX Aware Process Overview 

1. Connect to a QORTEX Aware Enabled Sensor (101). 

a. Add the sensor to the network. 

Note:  QORTEX Aware sensors spin up immediately upon power-on. So, when 
connecting to the sensor in Q-View, there is no delay in Q-View between clicking 
connect and the sensor showing as connected, because the sensor is already 
spinning. 

b. Install Q-View on a laptop that is connected to the network. 

c. Add the listening device.  

d. Start Q-View and add sensors.  

2. Click the QORTEX Aware tab and configure the zones to monitor through Q-View. 

o Create Evaluation Field Zones (page 108)—Areas to assess for objects. 
o Create Exclusion Zones (page 111)—Areas to ignore. 

3. Upload an Edited Settings File to the Sensor (page 115) —Apply configuration to the sensor.  

4. View Sensor settings: QORTEX Aware Monitor Mode (page 106)—View sensor activity through from 
sensor. See Figure 65. QORTEX Aware Modes and settings Files. 
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Figure 65. QORTEX Aware Modes and settings Files 

QORTEX Aware Configuration in Q-View 

 QORTEX Aware panel has modes, configuration tabs, and panels: 

• Monitor Mode—Shows what is happening on the sensor including Evaluation field switches from 
listening device (DIO). It shows the active Evaluation field from the sensor and alarms the sensor is 
showing. This includes the active evaluation field (set either via switches from the digital input or via the 
software API), the associated evaluation zones, and any alarms. 

• Configure Mode—Allows for configuring zones and fields and other parameters. QORTEX Aware runs 
inside Q-View and the display does not depend on what is going on with the sensor. The 
upload/download functions allow for synchronizing with the sensor but when in Configure mode, you 
only see what is calculated locally. Allows for zone and other settings configuration. Q-Alert processing 
runs from within Q-View. This mode does not show the configuration that is on the sensor. The 
Upload/Download functions allow for synchronizing with the sensor 

• Settings—Modify default settings for: output response – the desired interpretation of high/low voltage 
on the output line, debounce time to clear zone response, and sensitivity – the number of points 
required to indicate a zone is violated. 

• Exclusion Zones— Define the areas to ignore. Data points gathered within exclusion zones are not 
included in detection actions. Exclusion zones display as gray in Q-View. 

• Evaluation Field Zones—Define the areas to include for identification and notification of objects. 
Evaluation Field zones are blue when no objects are detected. Evaluation Field zones are red when one 
or more objects are detected.  
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To view QORTEX Aware panel, from Q-View, click the QORTEX Aware tab, . See Figure 66. QORTEX Aware: 
Configuration Panel and Visualizer Elements. 

 
Figure 66. QORTEX Aware: Configuration Panel and Visualizer Elements 
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QORTEX Aware Evaluation Fields and Zones 

Use QORTEX Aware to create different Evaluation fields to suit varying scenarios. QORTEX Aware flags 
impingements in Evaluation Field zones through the software API. Create up to 8 Evaluation Fields, each with 
up to 128 2D zones. Only one Evaluation Field is active at a time.  

Response time for the Q-Aware is dependent on the number of zones and the number of points in or near the 
zones. To guarantee the best possible response time, see Table 15. Maximum Number of QORTEX Aware 
Supported Zones. 

Table 15. Maximum Number of QORTEX Aware Supported Zones 

Zone Type Full FOV Active FOV reduced to 90º 

Polygons 8 32 

Squares 20 80 

Sectors 36 128 

 
For Q-View 1.6 ONLY, M1 Edge sensors: Qortex Aware can also flag impingements in the Evaluation Field 
zones through the sensor hardware pins. 

Connect the QORTEX Aware Components 

Ensure all the QORTEX Aware components are on the same network.  

1. Install Q-View, see Q-View Users Guide. Ensure it is on the same network as the sensor.  

2. Install and configure a QORTEX Aware supported sensor, see Sensor Users Guide. 

3. Connect listening device. See the manufacturer’s documentation. Ensure it is on the same network as 
the sensor. 

Connect to a QORTEX Aware Enabled Sensor 

From within the Q-View interface, connect Q-View to a QORTEX Aware enabled sensor.  

1. Start Q-View. Wait for the sensor tiles to appear in the Dashboard panel. See Figure 67. Q-View 
Dashboard Tab, Green Connected Sensor. 

2. Connect Q-View to a located sensor. Click the sensor connect  button. 

The Sensor tile changes from blue to green. The sensor button changes to sensor disconnect  button. 
See Figure 67. Q-View Dashboard Tab, Green Connected Sensor.  
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QORTEX Aware sensors spin up immediately upon power-on. So, when connecting to the sensor in 
Q-View, there is no delay in Q-View between clicking connect and the sensor showing as connected, 
because the sensor is already spinning. 

 
Figure 67. Q-View Dashboard Tab, Green Connected Sensor 

3. Verify the connection, view live data from the connected senor. See Figure 68. Q-View Visualizer Live 
Point Cloud, Sensor Connected. 

 
Figure 68. Q-View Visualizer Live Point Cloud, Sensor Connected 

4. Select the Qortex Aware  tab and click the Sensor Connect button. 

When you click the QORTEX Aware tab: 

o If a sensor is not connected, the visualization panel is blank. The Q-View attached sensors are listed. 
Click a sensor to select and display the sensor point cloud.  

o If a sensor is not listed, return to the Q-View Dashboard and add a sensor. See Connect to an Online 
Sensor (page 49). 
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o If a sensor is connected, the point cloud for the sensor is displayed.  

▪ The point cloud color is white. This distinguishes it from the Q-View point cloud visualization.  
▪ Default opening is in QORTEX Aware Configure mode with no zones configured.  

Note:  In QORTEX Aware Configure mode, you configure zones. QORTEX Aware 
zones function from within Q-View. When creating zones is complete, upload this 
configuration to the sensor. 

 
Figure 69. QORTEX Aware Sensor Not Connect (left) Connected (right) 

Select Settings File 

The QORTEX Aware settings file defines the values for all settings (debounce time, sensitivity, etc.) and 
definition of all the Exclusion Zones and Evaluation Field zones.  

The QORTEX Aware mode determines which settings configuration you are viewing through the QORTEX 
Aware Visualizer.  

• Monitor mode—displays the sensor settings configuration. It does not display what is QORTEX Aware 
defined in Q-View. 

• Configure mode—displays the Q-View settings configuration. It does not display what’s on the sensor. 

settings files are stored to and accessible from three locations: Q-View, Network, and Sensor.  
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Important Settings File Notes 

• When you upload / save or download / browse a settings file, it overwrites the settings file in target 
location.  

• When the sensor is connected, to display any zones that are configured in the sensor, switch to Monitor 
mode or download the sensor’s settings file to Q-View.  

 
Figure 70. QORTEX Aware: Settings File Toolbar 

Q-View settings File 

Note:  The only settings file that is edited from QORTEX Aware, is the file open 
in the Q-View > QORTEX Aware tab.  

When Qortex Aware is initially opened in Q-View, the settings file does not have any zones or configuration 
other than default settings.  

The Q-View > QORTEX Aware settings is the file that you edit when you create or modify the QORTEX Aware 
configuration. This is the file whose configuration you see when QORTEX Aware is in Configure mode. This file 
can be Saved to a networked location or Uploaded to a sensor. When you upload this file to a sensor, it 
overwrites the sensor’s existing settings file.  

To get a settings file other than the default in the Q-View > QORTEX Aware tab, select the action from the 
QORTEX Aware settings bar. See Figure 70. QORTEX Aware: Settings File Toolbar. 

Sensor settings File 

Each sensor has its own settings file. QORTEX Aware on the sensor processes the point cloud data per the 
configuration defined in the sensor resident settings file.  

Sensor settings is the file whose configuration you see when QORTEX Aware is in Monitor mode. 
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Sensor settings files can be Downloaded to Q-View or Uploaded to the sensor. Downloading a settings file, 
overwrites the settings file in Q-View. Downloading the sensor’s settings file, allows Q-View to display the 
sensor configuration in Configure mode. Uploading a settings file, overwrites the settings file on the sensor. 

Note:  As you make changes to a downloaded settings file, they are applied to 
the Q-View settings file only. They are not applied to the sensor’s settings. 
Modified settings files must be Uploaded to the sensor to modify the sensor’s 
behavior. 

Sensor file actions:  

• To modify the sensor’s settings file, click Download . 

Download uses the sensor’s settings file and replaces the QORTEX Aware settings file in Q-View.  

This allows Q-View to display the sensor configuration in Configure mode. It also overwrites any 
configuration you created through the QORTEX Aware visualizer.  

• To apply the Q-View settings to the sensor, click Upload . 

Upload uses the QORTEX Aware settings file in Q-View and replaces the file on the sensor.  

Network settings File 

Network settings files can be opened into QORTEX Aware. When you browse to and open a networked 
settings file, it overwrites the settings file in QORTEX Aware. Network stored settings file can be saved 
from QORTEX Aware to a networked location. The only way to view saved network settings files is to open 
them, one at a time, in QORTEX Aware. 

Saved settings files store a copy on the network and do not affect the sensor behavior. 

Network File Actions 

• To load a configuration from a networked settings file to QORTEX Aware in Q-View, click Browse  , 
locate the networked settings file, and click Open. 

Browse uses the network stored settings file and replaces the QORTEX Aware settings file in Q-
View.  

This replaces the configuration in QORTEX Aware in Q-view, including zones and settings, with the 
configuration from the settings file. It does not change the settings files on the sensor.  

• To save the Q-View settings file to the network, click Save  the file and browse to the network 
location.  

Save copies the QORTEX Aware settings file in Q-View and saves the file on the network. The Q-View 
version remains active in the Q-View visualizer. 
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View Sensor settings: QORTEX Aware Monitor Mode 

In MONITOR mode, the object detection algorithm runs on the sensor and is displayed in the QORTEX Aware 
Visualization panel. Also, the CONFIGURE panel is removed from view in the Visualization panel. You can see 
the sensor point cloud updates, active Evaluation Zones and Exclusion Field zones, and zone violations.  

1. Open Q-View, connect to sensors, select QORTEX Aware  button.  

QORTEX Aware starts automatically when the sensor is powered on. 

2. Select MONITOR mode from the pull-down menu.  

 
Figure 71. QORTEX Aware: Monitor Mode 

View Q-View settings: QORTEX Aware Configure Mode 

While in configure mode, the visualization panel displays the visualization data and object detection, just the 
same as with MONITOR mode. The difference with CONFIGURE mode, is that the processing is performed in 
the Q-View application, rather than the sensor. This allows you to change settings and create zones without 
uploading / downloading settings from and to the sensor. See Figure 66. QORTEX Aware: Configuration Panel 
and Visualizer Elements. 

1. Open Q-View, connect to sensors, select QORTEX Aware  button.  

2. Connect a sensor to QORTEX Aware if one is not connected. See Connect to an Online Sensor (page 49) 
and Connect to a QORTEX Aware Enabled Sensor (page 101). 

QORTEX Aware starts automatically when the sensor is powered on. 

3. Select CONFIGURE mode from the pull-down menu, if it is not selected. Default after connecting to a 
sensor is CONFIGURE mode.  

The QORTEX Aware Configuration panel is displayed. See Figure 66. QORTEX Aware: Configuration 
Panel and Visualizer Elements. 
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View Sensor Field of View 

1. Open Q-View, connect to sensors, select QORTEX Aware  button > CONFIGURE mode. 

2. Optionally, check the field of view (FOV), click the FOV icon, . See the Sensor User Guide and the 
Sensor Web Server for setting the FOV. See Figure 72. QORTEX Aware: 360° Field of View.  

Note:  If you limit the sensor field of view, use this FOV toggle to confirm the 
zones you defined are within the sensor FOV. 

If you click from adding the sensor to QORTEX Aware to FOV too quickly, the visualizer panel might 
display a full 360° circle for the FOV, even if the FOV is set to be smaller than this. Give the sensor time 
to spin up, then re-click (toggle on/off) the FOV icon to allow it to receive the SNMP data from the 
sensor configuration.  

 
Figure 72. QORTEX Aware: 360° Field of View 
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Create Evaluation Field Zones 

Evaluation Field zones have the same zone types as Exclusion Zones. See Figure 78. QORTEX Aware: Visualizer 
with Evaluation Field Zones. 

1. Open Q-View, connect to sensors, select QORTEX Aware  button > CONFIGURE mode. 

2. Expand the Evaluation Fields panel.  

There are 8 possible Evaluation fields. Each Evaluation field can have up to 128 zones.  

Define zones appropriate for different evaluation scenarios. 

Evaluation Field zone color indicates activity in zones. See Figure 78. QORTEX Aware: Visualizer with 
Evaluation Field Zones. 

▪ The blue zones indicate no objects have been detected in the defined areas. 
▪ The red zone indicates an object has been detected the arc defined area.  

For Q-View 1.6 ONLY, M1 Edge sensors: One Evaluation Field is active at a time. Select the active 
Evaluation Field through either the device hardware pins or the Qortex Aware API. For example: 

▪ If your robot has different modes, such as fast mode, slow mode, or careful mode, then each 
individual mode could use a different evaluation field.  

▪ A stationary device monitors a safety area or secure access area. Depending upon the time-of-
day different Evaluation Fields might be appropriate.  

3. Add Evaluation Field, click the plus (+).  

Zone identification —The zone number in the data point panel have two parts, N:N. The first number 
indicates the Evaluation or Exclusion field. The second number indicates the specific zone within the 
evaluation field. The list panel shows the zones in binary. The point cloud panel shows the zone in 
decimal. For example, an Evaluation field 0000 in the list panel is Zone0 in the point cloud panel. 

 
Figure 73. QORTEX Aware  Evaluation Field ID Selection 

For Q-View 1.6 ONLY, M1 Edge sensors: the drop down is enabled to assign a binary number to control 
the input pins associated with the evaluation field. The default value is the lowest available pin 
combination. For example, 0001, if 0000 is already in use.  
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4. Expand the Evaluation, click the plus (+) in the list panel,  and select a zone ID number.  

 
Figure 74. QORTEX Aware Evaluation Field Zone ID Selection 

5. Draw the zone in the point cloud panel. See Figure 78. QORTEX Aware: Visualizer with Evaluation Field 
Zones. 

There are three zone types. These are defined by the shape of the zone.  

 
Figure 75. QORTEX Aware Zone Type Selection 

Polygon  —Click in the visualizer field. Continue to click until you define a closed area. Left-click to 
add a new point to the polygon and right-click to close the polygon. 

Rectangle  —Click in the visualizer field to define one vertex of the rectangle and click again to define 
the opposite vertex. This defines the shape. Make adjustments in the Configure bar fields as needed. 
Adjustment options: Width, Height, Rotate, Pos X, Pos Y. See Figure 76. QORTEX Aware: Rectangle Zone 
Configure Bar. 

 
Figure 76. QORTEX Aware: Rectangle Zone Configure Bar 

Arc  —The center of the arc is positioned at the sensor. Default is a full circle around the sensor. The 
center of the arc originates at the sensor origin. Make adjustments in the Configure bar fields as needed. 
Adjustment options: Radius, Start angle, End angle. The Start angle must be a value less than the End 
angle. Left-click to set the radius and drag the end of the radius to change it. See Figure 77. QORTEX 
Aware: Arc Zone Configure Bar. 
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Figure 77. QORTEX Aware: Arc Zone Configure Bar 

For Q-View 1.6 ONLY, M1 Edge sensors: the drop down is enabled. Select a value that corresponds to 
an output pin on the sensor. The default value is a hyphen (-) which means that the zone is not mapped 
to any pin. 

6. To edit an existing zone. Select the zone from the list panel. Then click the Configure Bar field’s ^/v to 
reposition or alter the size of the zone. See Figure 76. QORTEX Aware: Rectangle Zone Configure Bar and 
Figure 77. QORTEX Aware: Arc Zone Configure Bar. 

To change a Polygon zone, delete the zone. Click the trashcan icon by the zone name. Then create a 
new zone.  

 
Figure 78. QORTEX Aware: Visualizer with Evaluation Field Zones 

7. Save or Upload the zone configuration.  

o Click Save   to save the local settings file. This does not change the sensor behavior. 
o Click Upload  to replace the settings file on the sensor and run the detection from the sensor.  
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Note:  When you upload the changes, it overwrites any current settings file on 
the sensor.  

Create Exclusion Zones 

Creating Exclusion zones has the same zone types as Evaluation Fields. Exclusion zones apply across all 
Evaluation Fields. Exclusion zones display as gray areas. Objects in the gray zone are not detected. See Figure 
80. QORTEX Aware: Visualizer with Exclusion Zone. 

1. Open Q-View, connect to sensors, select QORTEX Aware  button > CONFIGURE mode. 

2. Expand the Exclusion Zones tab. 

3. Click the plus (+) to select a zone type and define the zone.  There are three zone types. These are 
defined by the shape of the zone.  

 
Figure 79. QORTEX Aware Zone Type Selection 

Polygon  —Click in the visualizer field. Continue to click until you define a closed area. 

Rectangle  —Click in the visualizer field to define one vertex of the rectangle and click again to define 
the opposite vertex. This defines the shape. Make adjustments in the Configure bar fields as needed. 
Adjustments options: Width, Height, Rotate, Pos X, Pos Y 

Arc  —Center of the arc is positioned at the sensor. Default is a full circle around the sensor. The 
center of the arc originates at the sensor origin. Make adjustments in the Configure bar fields as needed. 
Adjustments options: Radius, Start angle, End angle. The Start angle must be a value less than the End 
angle.  

4. Save or Upload the zone configuration.  

o Click Save   to save the local settings file. This does not change the sensor behavior. 
o Click Upload  to replace the settings file on the sensor and run the detection from the sensor.  

Note:  When you upload the changes, it overwrites any current settings file on 
the sensor.  
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Toggle Viewing Exclusion Zones 

Exclusion zones can be hidden from the display using the Exclusion zone panel eye  toggle.  

1. Open Q-View, connect to sensors, select QORTEX Aware  button > CONFIGURE mode. 

2. Click the eye icon  on the Exclusion Zone tab. See Figure 80. QORTEX Aware: Visualizer with Exclusion 
Zone. 

 
Figure 80. QORTEX Aware: Visualizer with Exclusion Zone 

Delete a Zone 

1. Open Q-View, connect to sensors, select QORTEX Aware  button > CONFIGURE mode. 

2. Expand the Evaluation Fields or Exclusion Zones panel.  

3. Select a zone to delete. Hover over the zone to delete and click the Trashcan  icon. 

The zone is deleted. There is no confirmation prompt. When you delete a zone, the existing zones do 
not change their assigned ID number.  

o For example, if you have 4 Exclusion zones, 0, 1, 2, 3, and you delete Exclusion zone 1, the existing 
Exclusion zones keep their ID numbers 0, 2, and 3. The same applies to Evaluation Field zones. 

o However, you can create a new zone in the deleted ID space. For example, if you have 3 Evaluation 
Field zones, 1.0, 1.1, and 1.2. You delete 1.1. You can click the plus (+) in zone list entry for 1.1 to 
add a new zone, of any type: polygon, rectangle, or arc.  

Exclusion Zone 0 

Exclusion zone toggle 
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Modify Default Non-Zone Settings 

Additional settings for detecting objects in zones can be modified. These are saved to the settings file, as part of 
the QORTEX Aware configuration for the sensor.  

1. Open Q-View, connect to sensors, select QORTEX Aware  button > CONFIGURE mode. 

2. Expand the Settings panel. See Figure 81. QORTEX Aware: Settings Panel Options. 

 
Figure 81. QORTEX Aware: Settings Panel Options 

Set Output Active Level 

This option only available for Q-View 1.6 ONLY, M1 Edge sensors. 

1. From Q-View, select QORTEX Aware  button > CONFIGURE > Settings panel. See Figure 81. QORTEX 
Aware: Settings Panel Options. 

2. Select the output signal level for trigger action when a zone is impinged.  

Select from the Settings tab > Output menu. Options are:  

o Active High—When this is selected, a high voltage means a zone is occupied. 
o Active Low—When this is selected, a 0 voltage means a zone is occupied. 

Output Active level sets the value of the output pin on the listening device when a zone is occupied. 
This is used to decide the type of response for a detection. Examples: 

o If you select Active High, a light could turn on when an object is detected.  
o If you select Active Low, the wheels on a mobile device could stop when an object is detected. 
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Set Debounce Time 

1. From Q-View, select QORTEX Aware  button > CONFIGURE > Settings panel. See Figure 81. QORTEX 
Aware: Settings Panel Options. 

2. Select the amount of time allowed before a zone status changes from OCCUPIED to CLEAR.  

In the Settings tab > Debounce field, click the ^/v arrows or type a number change the delay in seconds. 

Debounce is the time to wait for changing a zone from occupied to unoccupied. Debounce valid values 
are 0.00 to 1000.00 seconds with 2-decimal precision. Adjust the debounce time to reduce rapid alarm 
cycling with objects at the edge of zones. Higher values keep the red zone indication on longer. The 
prevents rapid flipping between red and blue.  

Debounce time does not affect the time to detect objects but extends the alert beyond the point when 
the object is no longer in the zone.  

Set Object Detection Sensitivity 

1. From Q-View, select QORTEX Aware  button > CONFIGURE > Settings panel. See Figure 81. QORTEX 
Aware: Settings Panel Options. 

2. Select the sensitivity value for triggering object detection in a zone. 

In the Settings tab > Sensitivity field, click the ^/v arrows or type a number between 1 and 10 to change 
the sensitivity.  

Sensitivity is the relative number of points in the point cloud required to indicate the zone is occupied. 
The highest sensitivity is 10. This setting requires only a single (1) point in the zone to indicate an 
OCCUPIED zone status.  

The least sensitivity is 1, this requires more points to trigger an OCCUPIED zone status.  

For example, adjust the setting so a very small object would not trigger a zone violation, but an animal or 
a person could trigger a zone violation.  

Set Active Evaluation Field 

Use the QORTEX Aware API to set the active Evaluation Field.  

To enable using the QORTEX Aware API to set the active Evaluation Field: 

1. From Q-View, select QORTEX Aware  button > CONFIGURE > Settings panel. See Figure 81. QORTEX 
Aware: Settings Panel Options. 

2. To use the Qortex Aware API to set the active Evaluation Field, select the Set Evaluation Field via S/W 
API checkbox.  The default active Evaluation Field is 0.  

For Q-View 1.6 ONLY, M1 Edge sensors: set the active Evaluation Field by adjusting the hardware pins on the 
sensor. See the M1 Edge User Guide > Appendix: QORTEX Aware APIs and Settings Commands. 
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Save an Edited Settings File to the Network 

When you save a settings file, you store a copy of the QORTEX Aware settings to a networked location. The 
Save action does not overwrite the settings on the sensor. 

1. Open Q-View, connect to sensors, select QORTEX Aware  tab. QORTEX Aware is in CONFIGURE 
mode by default. 

2. Make edits as needed to the QORTEX Aware Settings, Evaluation Fields, and/or Evaluation Field Zones. 
See Create Evaluation Field Zones  (page 108), Create Exclusion Zones (page 111), and Modify Default Non-
Zone Settings (page 113). 

3. Click the Save  button to store a copy of the settings file locally on the Q-View laptop.  

Give the settings file a useful name, such as lobby_zones, or weekend_zones. The settings files are in 
JSON format. Ensure the filename ends with the .json extension, manually add the .json if needed. 

4. Browse to a location on the Q-View machine and click Save.  

This saves a file on the local Q-View machine. It does not overwrite the settings file on the sensor. 

Note:  If you do not upload your configuration changes in the settings file, your 
changes are overwritten in QORTEX Aware visualizer when the settings file is 
next downloaded from the sensor.  

Edit the Q-View displayed configuration through QORTEX Aware to create zones. Then choose:  

o Save to make a copy of the QORTEX Aware settings file and store it locally.  
o Upload the modified QORTEX Aware settings file and overwrite the existing file on the sensor.  

Upload an Edited Settings File to the Sensor 

Upload the QORTEX Aware settings file, with any changes you have made, and overwrite the settings file on 
the sensor. 

1. Open Q-View, connect to sensors, select QORTEX Aware  tab. QORTEX Aware is in CONFIGURE 
mode by default. 

2. Make edits as needed to the QORTEX Aware Settings, Evaluation Fields, and/or Evaluation Field Zones. 
See Create Evaluation Field Zones  (page 108), Create Exclusion Zones (page 111), and Modify Default Non-
Zone Settings (page 113). 

3. Click the Upload  button to push and overwrite the settings file to the sensor.  

Note:  If you upload a Q-View 1.0 settings file, it is converted to a Q-View 2.0 
settings file. 
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Sample Settings File  

{ 

  "Settings": { 

    "ZoneDetector": { 

      "version": "2.0", 

      "debounceTimeMs": "3000", 

      "sensitivity": "9", 

      "triggerActiveLevel": "low", 

      "useSoftwareAPICommand":"true", 

      "ExclusionZone": { 

        "name": "tiny_circle", 

        "shape": "sector", 

        "Sector": { 

          "minAngle": "0", 

          "maxAngle": "6.283185307179586", 

          "radius": "0.01" 

        }, 

        "zMin": "-1.0", 

        "zMax": "1.0" 

      }, 

      "ExclusionZone": { 

        "name": "tiny_circle_2", 

        "shape": "sector", 

        "Sector": { 

          "minAngle": "0.5", 

          "maxAngle": "6.283185307179586", 

          "radius": "0.05" 

        }, 

        "zMin": "1.0", 

        "zMax": "2.0" 

      }, 

      "ExclusionZone": { 

        "name":"Exclusion Zone 1", 

        "shape":"rectangle", 

        "Rectangle":{ 

          "rotation":"0", 

          "Point": { 

            "x":"3.6292960643768311", 

            "y":"-0.17496338486671448" 

          }, 

          "Point": { 

            "x":"4.275385856628418", 
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            "y":"1.2150298357009888" 

          } 

        }, 

        "zMin": "4.0", 

        "zMax": "8.0" 

      }, 

      "EvaluationField": { 

        "name": "square_diamond", 

        "index": "2", 

        "Zone": { 

          "name": "square", 

          "index": "0", 

          "pin": "-1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-1", 

              "y": "-1" 

            } 

          }, 

          "zMin": "0.0", 

          "zMax": "5.0" 

        }, 

        "Zone": { 

          "name": "diamond", 

          "index": "1", 

          "pin": "-1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "5", 

              "y": "6" 
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            }, 

            "Point": { 

              "x": "6", 

              "y": "5" 

            }, 

            "Point": { 

              "x": "5", 

              "y": "4" 

            }, 

            "Point": { 

              "x": "4", 

              "y": "5" 

            } 

          }, 

          "zMin": "-2.0", 

          "zMax": "2.0" 

        }, 

        "Zone": { 

          "name": "triangle", 

          "index": "2", 

          "pin": "-1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "5", 

              "y": "0" 

            }, 

            "Point": { 

              "x": "5", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "6", 

              "y": "0" 

            } 

          } 

        } 

      }, 

      "EvaluationField": { 

        "name": "rectan_tiny_circle", 

        "index": "4", 

        "Zone": { 

          "name": "rectangle", 

          "index": "1", 
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          "pin": "-1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-6", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-4", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-4", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-6", 

              "y": "-1" 

            } 

          }, 

          "zMin": "0.0", 

          "zMax": "20.0" 

        }, 

        "Zone": { 

          "name": "tiny_circle", 

          "index": "2", 

          "pin": "-1", 

          "shape": "sector", 

          "Sector": { 

            "minAngle": "0", 

            "maxAngle": "6.283185307179586", 

            "radius": "0.01" 

          }, 

          "zMin": "0.0", 

          "zMax": "20.0" 

        }, 

        "Zone": { 

          "name": "rotated_rectangle", 

          "index": "0", 

          "pin": "-1", 

          "shape": "rectangle", 

          "Rectangle": { 

            "rotation": "90", 

            "Point": { 
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              "x": "2", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-2", 

              "y": "1" 

            } 

          }, 

          "zMin": "0.0", 

          "zMax": "20.0" 

        } 

      }, 

      "EvaluationField": { 

        "name": "square_in_sectors", 

        "index": "7", 

        "Zone": { 

          "name": "square_inner", 

          "index": "0", 

          "pin": "-1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-6", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-5", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-5", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-6", 

              "y": "-1" 

            } 

          }, 

          "zMin": "0.0", 

          "zMax": "20.0" 

        }, 

        "Zone": { 

          "name": "sector_large", 

          "index": "1", 
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          "pin": "-1", 

          "shape": "sector", 

          "Sector": { 

            "minAngle": "-1.570796326794897", 

            "maxAngle": "1.570796326794897", 

            "radius": "1" 

          }, 

          "zMin": "0.0", 

          "zMax": "20.0" 

        }, 

        "Zone": { 

          "name": "sector_small", 

          "index": "2", 

          "pin": "-1", 

          "shape": "sector", 

          "Sector": { 

            "minAngle": "-0.7853981633974483", 

            "maxAngle": "0.7853981633974483", 

            "radius": "0.5" 

          }, 

          "zMin": "0.0", 

          "zMax": "20.0" 

        } 

      } 

    } 

  } 

}} 

Figure 82. Sample Q-View 2.0 settings.xml File 

{ 

  "Settings": { 

    "ZoneDetector2D": { 

      "version": "0", 

      "debounceTimeMs": "3000", 

      "sensitivity": "9", 

      "triggerActiveLevel": "low", 

      "useSoftwareAPICommand":"true", 

      "ExclusionZone": { 

        "name": "tiny_circle", 

        "shape": "sector", 

        "Sector": { 

          "minAngle": "0", 

          "maxAngle": "6.283185307179586", 

          "radius": "0.01" 
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        } 

      }, 

      "ExclusionZone": { 

        "name": "tiny_circle_2", 

        "shape": "sector", 

        "Sector": { 

          "minAngle": "0.5", 

          "maxAngle": "6.283185307179586", 

          "radius": "0.05" 

        } 

      }, 

      "ExclusionZone": { 

        "name":"Exclusion Zone 1", 

        "shape":"rectangle", 

        "Rectangle":{ 

          "rotation":"0", 

          "Point": { 

            "x":"3.6292960643768311", 

            "y":"-0.17496338486671448" 

          }, 

          "Point": { 

            "x":"4.275385856628418", 

            "y":"1.2150298357009888" 

          } 

        } 

      }, 

      "EvaluationField": { 

        "name": "square_diamond", 

        "index": "2", 

        "Zone": { 

          "name": "square", 

          "index": "0", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 
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              "y": "-1" 

            }, 

            "Point": { 

              "x": "-1", 

              "y": "-1" 

            } 

          } 

        }, 

        "Zone": { 

          "name": "diamond", 

          "index": "1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "5", 

              "y": "6" 

            }, 

            "Point": { 

              "x": "6", 

              "y": "5" 

            }, 

            "Point": { 

              "x": "5", 

              "y": "4" 

            }, 

            "Point": { 

              "x": "4", 

              "y": "5" 

            } 

          } 

        }, 

        "Zone": { 

          "name": "triangle", 

          "index": "2", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "5", 

              "y": "0" 

            }, 

            "Point": { 

              "x": "5", 

              "y": "1" 

            }, 
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            "Point": { 

              "x": "6", 

              "y": "0" 

            } 

          } 

        } 

      }, 

      "EvaluationField": { 

        "name": "rectan_tiny_circle", 

        "index": "4", 

        "Zone": { 

          "name": "rectangle", 

          "index": "1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-6", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-4", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-4", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-6", 

              "y": "-1" 

            } 

          } 

        }, 

        "Zone": { 

          "name": "tiny_circle", 

          "index": "2", 

          "shape": "sector", 

          "Sector": { 

            "minAngle": "0", 

            "maxAngle": "6.283185307179586", 

            "radius": "0.01" 

          } 

        }, 

        "Zone": { 
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          "name": "rotated_rectangle", 

          "index": "0", 

          "shape": "rectangle", 

          "Rectangle": { 

            "rotation": "90", 

            "Point": { 

              "x": "2", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-2", 

              "y": "1" 

            } 

          } 

        } 

      }, 

      "EvaluationField": { 

        "name": "square_in_sectors", 

        "index": "7", 

        "Zone": { 

          "name": "square_inner", 

          "index": "0", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-6", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-5", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "-5", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-6", 

              "y": "-1" 

            } 

          } 

        }, 

        "Zone": { 

          "name": "sector_large", 
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          "index": "1", 

          "shape": "sector", 

          "Sector": { 

            "minAngle": "-1.570796326794897", 

            "maxAngle": "1.570796326794897", 

            "radius": "1" 

          } 

        }, 

        "Zone": { 

          "name": "sector_small", 

          "index": "2", 

          "shape": "sector", 

          "Sector": { 

            "minAngle": "-0.7853981633974483", 

            "maxAngle": "0.7853981633974483", 

            "radius": "0.5" 

          } 

        } 

      } 

    } 

  } 

} 

Figure 83. Sample Q-View 1.0 settings.xml File
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 Troubleshooting Issues 
Most problems have fairly simple solutions that can be resolved by following the suggestions provided below.  

Get Help of Any Kind 

Contact your support representative to create an automatic support ticket and get the specific help you need. 
Provide the sensor serial number if appropriate.  

• If you purchased your hardware and software from Quanergy, send email to support@quanergy.com 
with your feedback, question, or concern. 

• If you purchased your hardware and software from a value-added reseller (VAR) or system integrator 
(SI), contact them for support.  

Can't Find My Sensors 

If you are not seeing the sensors you expect, verify the following: 

• The sensors are plugged into the same subnet as the machine running Q-View. 

• The sensors are plugged into suitable power sources, as specified in the relevant Sensor User Guide.  

• Be patient and refresh the search for sensors again by selecting the Search network  button. 
Sometimes, a sensor may take as long as a minute to come fully online. 

• If the host computer went into sleep mode, the sensors can be in unpredictable states. If this occurs, 
refresh the search for sensors by selecting the Search network  button. After the first search 
concludes, you might need to refresh again. Repeat the refresh sequence until the sensors return to the 
individual states you expected them in.  

Q-View Crashed 

Q-View is a highly reliable application, but network conditions are hard to predict.  

• If Q-View crashes a time or two, just restart it again. It remembers everything you've done, so you can 
pick up where you left off. 

• If Q-View continuously crashes every time you open it, please contact your customer support 
representative, and explain what happened. 

mailto:support@quanergy.com?subject=Support%20Troubleshooting


Q-View User Guide 
 
 

 

©2024 Quanergy Solutions, Inc Q-Vew User Guide, QPN 96-00015 Rev M Page 128 

Point Cloud Has Missing Portions 

If the visualization of the point cloud omits some portions of the display, too many sensors might be in a 
Connected (green) or Malfunctioning (red) state. For optimal results in visualizing point clouds, Quanergy 
recommends connecting to up to 18 sensors in single return mode. 

Sensor is Malfunctioning 

If a sensor enters a Malfunctioning (red) state, refresh the display of sensors by selecting the Search network  
button to clear up any minor anomalies. If Q-View persists in displaying the connected sensor in a 
Malfunctioning (red) state, check the diagnostics panel to see which error code is reported. See Figure 30. 
Dashboard Tab: Diagnostics Panel Sensor Error.  

• For sensor error codes causes and possible solutions, see “Troubleshooting Issues” in the Sensor User 
Guide.  

Qortex Aware Output Rate is Decreasing 

A reduction in Qortex Aware output rate, could be due to sensor processors being overly taxed which might 
result in sensor frames being dropped. Check if too many zones are defined in a certain way.  
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Appendix 1. QORTEX Aware APIs and Settings 

Commands 

Using Q-View to configure QORTEX Aware, is strongly recommended.  

For advanced users who do not want to use Q-View for QORTEX Aware configuration or who wish to configure 
QORTEX Aware with their own custom GUI, the following JSON based API can be used to configure QORTEX 
Aware. 

THE QORTEX Aware API is accessed through port 4143. This port allows you to dynamically select the active 
Evaluation Field, provides information on zone violations, and allows for uploading / downloading settings.  

All commands to the server must be newline-delimited JSON (NDJSON) strings. A NDJSON message is 
produced by removing all instances of \r (carriage return), \n (line feed), a \t (tab) from the original JSON 
message and appending a single \n (newline) at the end of the message. Pretty JSON is shown for example here 
for readability, but all new lines (except at the end of the message) should be removed.  

This guide uses ‘pretty’ JSON in the examples, however, when you create JSON files or API content be sure to 
use the NDJSON format. See Figure 84. Settings API: Sample JSON Formats. 

Example pretty JSON 

{ 

 "command" : "select_evaluation_field", 

 "evaluationFieldIndex" : "0" 

} 

Example NDJSON 

"{\"command\":\"select_evaluation_field\",\"evaluationFieldIndex\":\"0\"}\n" 

Figure 84. Settings API: Sample JSON Formats 

The Qortex Aware API contains: 

• Control messages (sent to server) 

o Set current evaluation field 
o Request settings from server 
o Settings upload 

• Information messages (received from server) 

o Zone violations 
o Command acknowledgement 
o Settings 
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Command Message Sent to QORTEX Aware Server 

The QORTEX Aware server accepts: 

• A command to select the active evaluation field.  

• A request to get the settings from the sensor 

• A message to upload the settings. 

command Object 

The select_evaluation_field and get_settings commands use the command object described here. See 
Set Active Evaluation Field (page 130) and Request Settings (page 130). 

Definitions: See Table 16. QORTEX Aware API: command Object. 

Table 16. QORTEX Aware API: command Object 

Key Type Values Description 

command string select_evaluation_field 
or get_settings 

Use to issue a command to QORTEX 
Aware server. 

evaluationFieldIndex string Zero-based index of the 
evaluation field to activate. 
(0-7) 

This field is required for the 
select_evaluation_field 
command. 

 

Set Active Evaluation Field 

Example: See Figure 85. QORTEX Aware API: Select Evaluation Field. 

Command Format 

{ 

 “command” : “select_evaluation_field”, “evaluationFieldIndex” : “0” 

} 

Figure 85. QORTEX Aware API: Select Evaluation Field 

Request Settings 

Example: See Figure 86. QORTEX Aware API: Request Settings. 

Command Format 

{ 

 “command” : “get_settings” 

} 

Figure 86. QORTEX Aware API: Request Settings 
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Upload Settings 

Upload settings by passing the updated whole settings file as Newline delimited JSON string to server. 
Notice that there's no command in this message.  

Example: See Figure 87. QORTEX Aware 1.0 API: Upload Settings. 

{ 

  "Settings": { 

    "ZoneDetector2D": { 

      "version": "1.0", 

      "debounceTimeMs": "3000", 

      "sensitivity": "9", 

      "triggerActiveLevel": "low", 

      "useSoftwareAPICommand": "true", 

      "ExclusionZone": { 

        "name": "tiny_circle", 

        "shape": "sector", 

        "Sector": { 

          "minAngle": "0", 

          "maxAngle": "6.283185307179586", 

          "radius": "0.01", 

        } 

      }, 

      "EvaluationField": { 

        "name": "square_diamond", 

        "index": "2", 

        "Zone": { 

          "name": "square", 

          "index": "0", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "-1" 

            }, 

            "Point": { 
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              "x": "-1", 

              "y": "-1" 

            } 

          } 

        } 

      } 

    } 

  } 

} 

Figure 87. QORTEX Aware 1.0 API: Upload Settings 

Example: See Figure 88. QORTEX Aware 2.0 API: Upload Settings. A summary of the changes between version 1.0 
and 2.0: 

• "version" 1.0 > 2.0 

• "ZoneDetector2D" > "ZoneDetector" 

• "zMin" and "zMax" (new settings for each shape) 

• "pin" (new setting for each evaluation field) 

{ 

  { 

  "Settings": { 

    "ZoneDetector": { 

      "version": "2.0", 

      "debounceTimeMs": "3000", 

      "sensitivity": "9", 

      "triggerActiveLevel": "low", 

      "useSoftwareAPICommand": "true", 

      "ExclusionZone": { 

        "name": "tiny_circle", 

        "shape": "sector", 

        "Sector": { 

          "minAngle": "0", 

          "maxAngle": "6.283185307179586", 

          "radius": "0.01", 

          "zMin": "-1.0", 

          "zMax": "0.5" 

        } 

      }, 

      "EvaluationField": { 

        "name": "square_diamond", 

        "index": "2", 

        "Zone": { 
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          "name": "square", 

          "index": "0", 

          "pin":"-1", 

          "shape": "polygon", 

          "Polygon": { 

            "Point": { 

              "x": "-1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "1" 

            }, 

            "Point": { 

              "x": "1", 

              "y": "-1" 

            }, 

            "Point": { 

              "x": "-1", 

              "y": "-1" 

            } 

          }, 

          "zMin": "0.0", 

          "zMax": "5.0" 

        } 

      } 

    } 

  } 

} 

Figure 88. QORTEX Aware 2.0 API: Upload Settings 

Messages Sent from QORTEX Aware Server 

The QORTEX Aware server outputs: 

• A recurring zone violation message 

• An acknowledgement message that is sent upon receipt of a command message 

• The settings, when requested by a get_settings command.  
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ZoneViolations 

These messages are sent with every frame of sensor data (at the same frequency of the sensor) to indicate the 
current zone violation status. See Table 17. QORTEX Aware API: zoneViolations Object Definitions. 

Table 17. QORTEX Aware API: zoneViolations Object Definitions 

Key Type Values Description 

EvaluationField number 0-7 Index of currently active evaluation field.  

ZoneStatus array One of: -1, 0, 1 Array containing three integer values, one for each 
zone. 
-1, zone does not exist 
0, zone is unoccupied 
1, zone is occupied 

 

Example: See Figure 89. QORTEX Aware 1.0 API: zoneViolations Object. 

zoneViolation Message 

{ 

 “zoneViolations” : { 

  “EvaluationField” : 0, 

  “ZoneStatus” : [0, 1, -1] 

 } 

} 

Figure 89. QORTEX Aware 1.0 API: zoneViolations Object 

Example: See Figure 90. QORTEX Aware 2.0 API: zoneViolations Object.  

zoneViolation Message 

{ 

 “zoneViolations” : { 

  “EvaluationField” : 0, 

  “ZoneStatus” : [ 0,1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-

1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-

1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-

1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-

1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1 ] 

 } 

} 

Figure 90. QORTEX Aware 2.0 API: zoneViolations Object 
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Settings File Content  

A message containing the QORTEX Aware settings file content is sent after a get_settings command is 
received and acknowledged. Note: the entire QORTEX Aware settings file is included in the message. See 
Figure 87. QORTEX Aware 1.0 API: Upload Settings. 

If you have a QORTEX Aware 1.0 settings file and open it in Q-View, the file is converted to QORTEX Aware 2.0 
version.  

Command Acknowledgement 

The following message is sent to acknowledge receipt of a Command message, provide feedback on whether the 
command was valid, whether the command was performed successfully. If the command was a request for 
information (currently just the get_settings command falls in this category), the data is sent in a separate 
message. See Table 18. QORTEX Aware API: commandAck Object Definitions. 

Table 18. QORTEX Aware API: commandAck Object Definitions 

Key Type Values Description 

command String  Echo of the command that is being 
acknowledged 

success Boolean  True, if the command was successful 

error_message String  Any errors encountered or empty if the 
command was successful 

 

Example: See Figure 91. QORTEX Aware API: commandAck Message. 

commandAck Message 

{ 

 "commandAck" : { 

   "command" : "get_settings", 

   "success" : true, 

   "error_message" : "" 

   }   

} 

Figure 91. QORTEX Aware API: commandAck Message 

QORTEX Aware Configuration API — JSON Object Definitions 

The QORTEX Aware settings file description includes: the JSON structure, a description of each item, and the 
validation that is done by the QORTEX Aware server. 
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Settings Object 

The Settings object is contained in the QORTEX Aware settings.json file. See Table 19. QORTEX Aware API: 
Settings Object JSON Definitions. 

Table 19. QORTEX Aware API: Settings Object JSON Definitions 

Key Type Values JSON Validation Description 

ZoneDetector2D Object See ZoneDetector2D 

description 

Required  

ZoneDetector2D Object 

Definitions: See Table 20. QORTEX Aware API: zoneDetector2D Object JSON Definitions. 

Table 20. QORTEX Aware API: zoneDetector2D Object JSON Definitions 

Key Type Values JSON Validation Description 

version String n/a Required, value is 
checked to be in 
format x.y and 
specifically 1.y or 0.y 

Used to track settings 
version. 

debounceTimeMs String Integer >= - Required. Non-integers 
or integers outside of 
the valid range are 
rejected. 

Time (in milliseconds) to 
debounce for changing 
from OCCUPIED to 
CLEAR. 

sensitivity String Integer between 1 

and 10 

Required. Non-integers 
or integers outside of 
the valid range are 
rejected. 

Sensitivity to a zone being 
flagged as occupied. 
Higher sensitivity values 
require fewer points in the 
zone. 

triggerActiveLevel String One of: 

High 

Low 

Required. Must be one 
of: "high" or "low" 

Specifies the value of the 
output pin when a zone is 
occupied (violated). 

useSoftwareAPICommand String True or false Optional. Must be one 
of: "true" or "false" 
Default is false 

Boolean indicating 
whether to allow updating 
evaluation field via s/w 
API command (true) or 
h/w (false). 

ExclusionZones Array Between 0 and 32 
Zone objects 

Required, but the array 
can be empty. 
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Key Type Values JSON Validation Description 

EvaluationFields Array Between 0 and 7 

EvaluationField 

objects 

Required, but the array 
can be empty. 

 

EvaluationField Object 

Definitions: See Table 21. QORTEX Aware API: EvaluationField Object JSON Definitions. 

Table 21. QORTEX Aware API: EvaluationField Object JSON Definitions 

Key Type Values JSON Validation Description 

name String Not empty and 

maximum of 18 

characters 

Strings that are empty 
or contain more than 
the maximum number 
of characters are 
rejected. 

Descriptive name for this 
Evaluation Field. 

index String Integer between 0 

and 7 

Required. Non-integers 
or integers outside of 
the valid range are 
rejected. 
Must not be the same 
as any other 
EvaluationField index. 

Index number for this 
Evaluation Field. 

Zones Array Between 1 and 3 

Zone objects. 

Required. Array 
containing less than one 
or more than 3 entries 
is rejected. 

The zones associated with 
this Evaluation Field 

 

Zone Object 

Definitions: See Table 22. QORTEX Aware API: zoneDetector2D Object JSON Definitions. 

Table 22. QORTEX Aware API: zoneDetector2D Object JSON Definitions 

Key Type Values JSON Validation Description 

Name String Not empty and 
maximum of 18 
characters 

Strings that are empty or contain more 
than the maximum number of 
characters are rejected. 

Descriptive name for 
this object. 

Index String Integer between 
0 and 2  

Required for Evaluation Field zones. 
Not required for Exclusion Zones. 

Index number for this 
zone. 
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Key Type Values JSON Validation Description 

Non-integers or integers outside of 
the valid range are rejected. 
Must not be the same as any other 
Zone index. 

Shape String One of 
Sector 
Rectangle 
polygon 

Required. Must be one of: "sector", 
"rectangle" or "polygon". 
There must be a corresponding Sector, 
Rectangle or Polygon object for the 
zone. 

The shape of this zone. 

Sector Object See sector object 
description. 

Required, when shape is "sector" Details of this zone's 
sector shape. This object 
is only required or 
present if "shape" is set 
to "sector". 

Rectangle Object See rectangle 
object 
description. 

Required, when shape is "rectangle" Details of this zone's 
rectangle shape. This 
object is only required or 
present if "shape" is set 
to "rectangle". 

Polygon Object See polygon 
object 
description.  

Required, when shape is "polygon" Details of this zone's 
polygon shape. This 
object is only required or 
present if "shape" is set 
to "polygon". 

zMin String Floating point 

value 

Points with a Z value less than zMin 
are always excluded from the zone. 
This value is ignored for single beam 
sensors. 

Requires QORTEX Aware 
2.0 or later.  
Optional.  
Default 0.0m.  
Value added to JSON 
object. 

zMac String Floating point 
value 

Points with a Z value greater than 
zMax are always excluded from the 
zone. 
This value is ignored for single beam 
sensors. 

Requires Qortex Aware 
2.0 or later.  
Optional.  
Default 20.0m.  
Value added to JSON 
object. 
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Sector 

Definitions: See Table 23. QORTEX Aware API: Sector Object JSON Definitions. 

Table 23. QORTEX Aware API: Sector Object JSON Definitions 

Key Type Values JSON Validation Description 

minAngle String Angle (radians) 

between -2π and +2π 

Required. Must be a 
numeric value. 

Sector minimum angle. 

maxAngle String Angle (radians) 

between -2π and +2π 

Required. Must be a 
numeric value. 

Sector maximum angle. 

Radius String Positive floating point 

value (meters) 

Required. Must be a 
numeric value greater 
than zero. 

Sector radius. 

Rectangle 

Definitions: See Table 24. QORTEX Aware API: Rectangle Object JSON Definitions. 

Table 24. QORTEX Aware API: Rectangle Object JSON Definitions 

Key Type Values JSON Validation Description 

Rotation String Floating point angle Required. Must be a 
numeric value. 

Rectangle rotation angle 
(degrees). 

Points Array Exactly two Point 

objects 

Required. Array 
containing anything other 
than 2 entries is rejected. 

The opposite corners of 
the rectangle. 

Polygon 

Definitions: See Table 25. QORTEX Aware API: Polygon Object JSON Definitions. 

Table 25. QORTEX Aware API: Polygon Object JSON Definitions 

Key Type Values JSON Validation Description 

Points Array Between 3 and 16 

Point objects. 

Required. Array 
containing less than three 
or more than 16 entries is 
rejected. 

The vertices 
representing a closed 
loop polygon. 
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Point 

Definitions: See Table 26. QORTEX Aware API: Point Object JSON Definitions. 

Table 26. QORTEX Aware API: Point Object JSON Definitions 

Key Type Values JSON Validation Description 

X String floating point number Required. Must be a 
numeric value. 

X coordinate of this point 

Y String floating point number Required. Must be a 
numeric value. 

Y coordinate of this point 

Additional Settings Validation 

The following validations are applied to the settings file: 

• maximum file size: 100k 

• maximum number of evaluation field: Qortex Aware version and sensor specific. See Table 27. QORTEX 
Aware API: Versions, Evaluation Zones, and Mapping. 

Table 27. QORTEX Aware API: Versions, Evaluation Zones, and Mapping  

Q-View version / Qortex 
Aware version / Sensor 

Maximum 
Evaluation Fields 

Maximum Number of 
Zones per Field 

Zone to output pin mapping 

1.6, 1.0, M1 Edge 8 3 Zone mapped to output pin 

1.7, 2.0, M1 Edge PoE 8 128 No zone mapping, sensor does not have 
pins. 

 

• name length (evaluation field, zone, exclusion zone): not empty and maximum is 20 

• number of zones in evaluation field: not empty and maximum is 128 

• maximum number of exclusion zones: 32 

• maximum number of vertices in polygon exclusion zone: 16 
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Setting Active Evaluation Field Example 

The following examples shows: 

• Running the API command in one terminal, selecting a zone.  

• In another terminal, the continuous zone status.  

• In the Visualization panel, the changing and monitored zones.  

Example: See Figure 92. QORTEX Aware API: Set Active Evaluation Field. 

Command Format 

{ 

 “command” : “select_evaluation_field”, “evaluationFieldIndex”:”1” 

} 

Figure 92. QORTEX Aware API: Set Active Evaluation Field 

The next set of figures provide an example of changing the Evaluation Field through the Qortex Aware API and 
status changes.  

• Change to Evaluation Zone 1 using Qortex Aware JSON command. See Figure 93. QORTEX Aware: JSON 
Command Setting Zone 1. 

• Selected Evaluation Zone Status from Evaluation Zone 1 to Evaluation Zone 2. Both Q-View > QORTEX 
Aware tab view and CLI view. See Figure 94. QORTEX Aware: Evaluation Field from Evaluation Field 0 to 
Evaluation Field 1. 

 

Figure 93. QORTEX Aware: JSON Command Setting Zone 1 

 

Change Evaluation Field selection to Evaluation Field 1 
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Figure 94. QORTEX Aware: Evaluation Field from Evaluation Field 0 to Evaluation Field 1  

• Change to Evaluation Zone 2 using Qortex Aware JSON command. See Figure 95. QORTEX Aware: JSON 
Command Setting Zone 2. 

• Selected Evaluation Zone Status from unoccupied to occupied. Both Q-View > QORTEX Aware tab view 
and CLI view. See Figure 96. QORTEX Aware: Zone 2 Status Change from Unoccupied to Occupied. 

 

 

Figure 95. QORTEX Aware: JSON Command Setting Zone 2 

 

Evaluation Field 1 status 0: unoccupied 

Evaluation Field 1 selection, 
zone 0, no violation/unoccupied 

Evaluation Field 1 
selection 

Evaluation Field 0 status tracking 

Command to switch to Evaluation Field 1 applied. 

Change Evaluation Field selection to Evaluation Field 2 
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Figure 96. QORTEX Aware: Zone 2 Status Change from Unoccupied to Occupied  

 

 

 

Evaluation Field 2, zone with 
violation 

Evaluation Field 2 status 0: no violation, unoccupied 

Evaluation Field 2 
selection 

Evaluation Field 2 status 1: violation, occupied 
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